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New Installation Checklist 
The following is a checklist of the overall steps needed to install Costpoint 8.2. Details for each step are 
provided on subsequent pages.  

Print this checklist and use it as you complete this installation, if desired. 

 Step Summary Notes 

Database Tier Installation 

 1. Install Costpoint Database using Database Tier 
Installer 

 

 2. Enable JDBC Distributed Transactions  

Application Tier Installation 
 1. Install Application Tier Software  

 2. Add Users to the CostpointToolsGroup  

 3. Start Costpoint 8.2  

 4. Install Costpoint 8.2 Windows Service  

 5. Configure Costpoint 8.2 Windows Service  

Web Tier Installation (Microsoft IIS) 
 1. Configure Microsoft IIS for Costpoint 8.2  

 2. Install Web Tier Software  

 3. Add Users to the CostpointToolsGroup  

 4. Configure Costpoint 8.2 IIS Access  

 5. Restart Costpoint 8.2 WebLogic Server  

Using Costpoint 8.2 
 1. Log in to Costpoint 8.2  

Maintenance Release Installation 

 1. Install Latest Costpoint 8.2 Maintenance Release 
(MR) 
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Related Documentation 
The following table lists the additional documentation that downloads with this release. Except where 
noted, all the user guides and quick reference guides listed in this table are also available for download 
from the Deltek Customer Care Connect site. 

You need Adobe Reader 8.2 or higher to view the documents listed in this section. 

Release Notes 

Document Name Description 

Deltek Costpoint 8.2 Database Changes This document describes the database changes 
between the release of Costpoint 8.1 and 
Costpoint 8.2. 

Deltek Costpoint 8.2 Release Notes Major New Features and Enhancements: 
View the major new features and enhancements 
included in Costpoint 8.2. 

De-Supported Applications: View the 
applications that are no longer supported in 
Costpoint 8.2. 

Entity Relationship Diagrams (ERDs) 

Document Name Description 

DeltekCostpoint820TransactionSchema.zip This ZIP file contains the ERD for the Deltek 
Costpoint 8.2 Transaction schema. Use 
index.htm to view the ERD. 

DeltekCostpoint820SystemSchema.zip This ZIP file contains the ERD for the Deltek 
Costpoint 8.2 System schema. Use index.htm 
to view the ERD. 

DeltekCostpoint820AdminSchema.zip This ZIP file contains the ERD for the Deltek 
Costpoint 8.2 Admin schema. Use index.htm 
to view the ERD. 

DeltekCostpoint820PLTransactionSchema.zip This ZIP file contains the ERD for the Deltek 
Costpoint 8.2 Planning Transaction schema. 
Use index.htm to view the ERD. 

DeltekCostpoint820TETransactionSchema.zip This ZIP file contains the ERD for the Deltek 
Costpoint 8.2 Time & Expense Transaction 
schema. Use index.htm to view the ERD. 
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Technical Guides: 

Document Name Description 

Deltek Costpoint 8.2 Configuration Utility This document describes how to use the 
Costpoint Configuration Utility, which helps 
Costpoint administrators perform the most 
common configuration tasks. 

Deltek Costpoint 8.2 Content Management 
Integration 

This document describes how to configure 
and tune the Costpoint Content Management 
Integration (CMI) application to provide 
access to Microsoft SharePoint™, as well as 
other Content Management Systems (CMS) 
that are compliant with the Content 
Management Interoperability Standard 
(CMIS). 

Deltek Costpoint 8.2 DB Wizard Utility This document describes how administers can 
use the DB Wizard utility to apply licenses, 
run link views, and rebuild user menus as well 
as deploy and verify extensibility. 

Deltek Costpoint 8.2 Deployment Options 
Technical Overview 

This document provides a high-level overview 
of Costpoint configuration options, including 
server, database, and security options. 

Deltek Costpoint 8.2 Integration Overview This document provides a high-level overview 
of how Costpoint reports, processes, and data 
can be integrated with third-party applications 
via Web services. 

Deltek Costpoint 8.2 Integration Console This document is a detailed guide to the 
Costpoint Integration Console, which 
automates the process of integrating 
Costpoint reports, processes, and data with 
third-party applications via Web services. 

Deltek Costpoint 8.2 Maintenance Release 
Installation Guide 

This document describes how to apply 
Costpoint 8.2 MRs. 

Deltek Costpoint 8.2 Monitoring Utility This document describes how to use the 
Monitoring Utility to diagnose Costpoint 
configuration problems. 

Deltek Costpoint 8.2 Performance Optimization This document contains Costpoint 
performance tips and tricks, information on 
the configuration of the Deltek performance 
lab, as well as a list of optimized applications 
for the Oracle parallel SQL execution option. 
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Document Name Description 

Deltek Costpoint 8.2 Post Installation Hardening 
Guide 

This document presents common principles 
and recommendations that administrators 
should consider for post-installation hardening 
of the Costpoint server environment. 

Deltek Costpoint 8.2 Process Execution Modes This document describes the many options for 
executing reports and processes in Costpoint, 
including using interactive and batch modes 
and job servers. 

Deltek Costpoint 8.2 Security This document describes user authentication 
and other security safeguards in Costpoint. 

Deltek Costpoint 8.2 User Migration Utility This document describes how to migrate 
users from earlier Costpoint versions to 
Costpoint 8.2. 

Other Documents: 

Document Name Description 

Deltek Costpoint 8.2 Getting Started Guide This document describes instructions for 
accessing Costpoint applications as well as 
descriptions of menus, toolbars, and other 
global features. You will also find information 
on logging on to Costpoint, accessing the 
database, printing reports, reviewing online 
help, and contacting Deltek Customer Care 
and other client services. 

Deltek Costpoint 8.2 User Interface QRC This document is a quick reference card that 
you can keep handy and use for reference as 
you work in Costpoint 8.2. It describes how to 
navigate through the application. 

Deltek Costpoint 8.2 Shortcut Keys Toolbar 
Icons and Buttons QRC 

This document is a quick reference card that 
you can keep handy and use for reference as 
you work in Costpoint 8.2. It lists the shortcut 
keys available in Costpoint, as well as the 
toolbar icons and buttons. 

Deltek Costpoint 8.2 Views QRC This document is a quick reference card that 
you can keep handy and use for reference as 
you work in Costpoint 8.2. It explains the 
differences between Table View and Form 
View. 

Deltek Costpoint 8.2 Query and Lookup QRC This document is a quick reference card that 
you can keep handy and use for reference as 
you work in Costpoint 8.2. It explains how to 
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Document Name Description 
use the query and lookup functions in 
Costpoint, 

Deltek Costpoint 8.2 Extensibility Designer 
Coding Guide 

This document contains java coding 
information for Costpoint Extensibility 
developers. 

Deltek Costpoint 8.2 Extensibility Designer 
Quick Start Guide 

This document outlines the basic steps for 
creating and deploying extensibility. 

Deltek Costpoint 8.2 Extensibility Designer 
Report Guide 

This document describes how to extend a 
report. 

Deltek Costpoint 8.2 Extensibility Designer 
User Guide 

This document contains detailed instructions 
for using the Costpoint Extensibility Designer. 

Deltek Costpoint 8.2 Screen Customization 
and Business Logic Extensibility 

This document is an overview of Costpoint 
screen customization and business logic 
extensibility features. 
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New Installation Overview 
This document provides instructions for installing the Deltek Costpoint 8.2 software. During the installation 
process, you will perform the following actions: 

 Ensure that your system meets the installation prerequisites. 

 
 Install the Costpoint 8.2 Database Tier software to create your Costpoint 8.2 Transaction, 

System, and Admin databases, as well as your Costpoint 8.2 Planning (PL) Transaction and Time 
& Expense (TE) Transaction databases (if applicable). 

 Install the Costpoint 8.2 Application Tier software, which includes both the Oracle WebLogic® 
Server software and the Costpoint 8.2 software. 

 Install the Costpoint 8.2 Web Tier software to your Internet Information Server (if applicable). 

 Install the latest Costpoint 8.2 Maintenance Release (MR). 

 

Installation Package Contents 
The Costpoint 8.2 installation package contains the following: 

 Costpoint 8.2 Database Tier installer 

 Costpoint 8.2 Application Tier installer 

 Costpoint 8.2 Web Tier installer 

 Costpoint 8.2 Maintenance Release Installer 

 Deltek Costpoint 8.2 New Installation Guide for Microsoft SQL Server 

 Deltek Costpoint 8.2 Maintenance Release Installation Guide 

Installation Prerequisites 

Database Tier Installation Prerequisites 
Before you start the Database Tier installation process, your database server must meet the following 
software requirements. 

Prerequisite Component Details 

Software All product compatibility information is maintained in the Deltek Product 
Support Compatibility Matrix available on the Customer Care Support 
Site, available here. 

Note: Please refer to the Installation Prerequisites and System Requirements sections for 
additional information. Also, please review the full list of related documentation prior to 
installing Costpoint 8.2. 

Note: If you need help with this installation, please contact Deltek Costpoint Technical 
Support at 877.HLP.PROJ (877-457-7765). 

https://deltek.custhelp.com/app/answers/detail/a_id/38499
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Prerequisite Component Details 
Note the database compatibility levels: SQL Server 2022 (160), SQL 
Server 2019 (150). 

Passwords To run the installation, a password is required for Microsoft SQL Server 
SA user or any user with sysadmin privileges. 

Firewall Settings On your Database Server, the Microsoft SQL Server Instance Port 
(1433) must be open for Inbound and Outbound traffic through your 
firewall. 

For a Named Microsoft SQL Server Instance, one of the following must 
be met: 

 SQL Browser Service must be enabled and running, and SQL 
Browser UDP Port (1434) should be open for Inbound and 
Outbound traffic. 

 A dedicated port could be configured for the instance, and such a 
port should be open for Inbound and Outbound traffic. 

On your Database Server, make sure that Network discovery and file 
sharing options are switched on. 

Close all software applications running on the database server. 

To avoid memory contention, check the memory allocated for SQL Server and make sure that the server 
can allocate at least a minimum of 8 GB. 

Application Tier Installation Prerequisites 
Before you start the Application Tier installation process, the application server that will run your 
WebLogic Server and Costpoint 8.2 software must meet the following prerequisites. 

Prerequisite Component Details 

Software All product compatibility information is maintained in the Deltek Product 
Support Compatibility Matrix available on the Customer Care Support 
Site here. 

Costpoint 8.2 Server Startup Prerequisites 
Before you start Costpoint 8.2, the following requirement must be met. 

Prerequisite Component Details 

Server On your Database Server, the SQL Server Listener Port 1433 must be 
open for Inbound and Outbound traffic through your firewall. 

On your Database Server, make sure that the Network Discovery and 
File Sharing options are switched on. 

On your Application Server, the WebLogic Listener Port 7009 must be 
open for Inbound and Outbound traffic through your firewall. 

https://deltek.custhelp.com/app/answers/detail/a_id/38499
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Prerequisite Component Details 
On your Application Server, make sure that the Network Discovery and 
File Sharing options are switched on. 

Costpoint 8.2 Initial Log In Configuration Prerequisites 
Before you can log in to Costpoint 8.2, your Windows client computer must meet the following 
requirements. 

Prerequisite Component Details 

Software All product compatibility information is maintained in the Deltek Product 
Support Compatibility Matrix available on the Customer Care Support 
Site here. 

Adobe Reader 2020.xxx or higher. This is required only for users who 
want to print Costpoint 8.2 reports in PDF format. Make sure that you 
select the Display PDF in browser option in Preference settings for 
Adobe Acrobat Reader to avoid pulling up a blank browser screen when 
printing in PDF format. 

Web Tier Installation/Microsoft Internet Information Server (IIS) 
Configuration Prerequisites 
The web server that will host your Internet Information Server software must meet the following 
requirements. 

Prerequisite Component Details 

Software All product compatibility information is maintained in the Deltek Product 
Support Compatibility Matrix available on the Customer Care Support 
Site here. 

Installation Process for Costpoint 8.2 
The Costpoint 8.2 installation process includes the following steps. 

Component Change Details 

Database Tier Installation The Database Tier installer automatically creates the following user-
defined databases and users: 

 Transaction Schema (DELTEKCP/CPTRAN) 

 Admin Schema (DELTEKADM/CPADMIN) 

 System Schema (DELTEKSYS/CPSYSTEM) 

 PL Transaction Schema (DELTEKPL/PLTRAN), if applicable 

 TE Transaction Schema (DELTEKTE/TETRAN), if applicable 

 Link User (CPLINK_USER) 

https://deltek.custhelp.com/app/answers/detail/a_id/38499
https://deltek.custhelp.com/app/answers/detail/a_id/38499
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Component Change Details 

Application Tier Installation The Install function in the Application Tier automatically installs all 
necessary software and handles all configurations.  

The Application Tier installer automatically performs all the following 
actions: 

 Extracting JDK 

 Installing WebLogic 

 Extracting BIRT Lib Files 

 Extracting App Tier Class Files 

 Updating Config Files 

 Encrypting Passwords 

 Running LinkViews 

 Syncing Sys Settings Table 

 Applying License 

 Running LinkViews 

 Migrating Org Security Application Modules 

 Creating Demo License 

 Creating Shortcuts 

The Application Tier installer creates a CostpointToolsGroup with the 
following Sharing and Security permissions: 

 Full Sharing and Security Permissions on your Costpoint 8.2 Deltek 
directory (C:\Deltek)  

 Full Security Permissions on your WebLogic directory 
(C:\Oracle\Middleware14.1.1)  

Web Tier Installation The Install function in the Web Tier automatically installs all necessary 
software and handles all configurations.  

The Web Tier installer automatically performs all the following actions: 

 Extracting DEProxy Files 

 Extracting DEWebApp Files 

 Configuring Internet Information Server (IIS) 

 Resetting Internet Information Server (IIS) 

The Web Tier installer creates a CostpointToolsGroup with the 
following Sharing and Security permissions: 

 Full Sharing and Security Permissions on the folder containing your 
Costpoint 8.2 DEWebApp directory (C:\Deltek\Costpoint or 
C:\Deltek\Costpoint\82\applications) 
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Web Servers Supported in Costpoint 8.2 
The Costpoint 8.2 system supports the following web servers only: 

 Microsoft Internet Information Server  

 Oracle’s WebLogic Web server 

Naming Conventions 
The naming conventions specified in this section are used in all installation instructions detailed in this 
upgrade installation guide. 

Drive Letters 
The table below lists the drive letters used in the installation instructions. 

Drive Description 

C: This is the drive where the Costpoint 8.2 software is installed. 

Directory Names 
The table below lists the directory names used in the installation instructions. 

Directory Name Description 

ORACLE/MIDDLEWARE14.1.1 This is the name of the directory where the Oracle WebLogic 
software is installed. 

DELTEK This is the name of the directory where the Costpoint 8.2 software 
is installed. 

Database Names 
Deltek recommends creating the three Costpoint schemas in one SQL Server database. Clients are free 
to choose the database name. 

Database Name Description 

DELTEKCP This is the name of your Costpoint 8.2 database. This database includes the 
Transaction, System, and Admin functions. 

The table below lists database names used for each of the Costpoint functions, respectively. 

Database Name Description 

DELTEKCP This is the name of your Costpoint Transaction database. 

DELTEKSYS This is the name of the Costpoint System database. 

DELTEKADM This is the name of the Costpoint Admin database. 



New Installation Overview 

Microsoft SQL Server 11 

 

Database Name Description 

DELTEKPL This is the name of your Planning Transaction database. 

DELTEKTE This is the name of your Time & Expense Transaction database. 

Deltek Software Manager (DSM) 
Software installations, installation instructions, technical guides, and release notes are available for 
download from the Deltek Software Manager (DSM). You will also download future releases of Costpoint 
8.2 from DSM.  

DSM is the sole download source for hotfix files.  

Deltek Knowledge Base articles provide an explanation of the fixes and contain links to DSM for retrieval 
of the actual files. 

DSM Requirements 
You can run DSM from any desktop. You do not need to run DSM from Deltek application servers.  

To run DSM, you must meet the following requirements: 

 Windows XP or later 

 Microsoft .NET Framework 3.5 SP1 (3.5.1) 

The following Deltek Knowledge Base article contains a download link to the framework. It also has 
examples of what you may see if you do not have the framework installed: 

https://deltek.custhelp.com/app/answers/detail/a_id/52469 

 

DSM Documentation and Troubleshooting 
For more information on Deltek Software Manager, use the following links: 

 To view the online help for DSM, click here. 

 To view a tutorial on how to use DSM, click here.  

 To view information about troubleshooting DSM, click here. 

This link works only when you are logged in to Deltek Customer Care Connect. 

Knowledge Base Documentation 

To view Knowledge Base articles: 
1. Go to http://www.deltek.com and click Support Login. 

2. Enter your logon credentials in the following fields, and then click Log In: 

Note: Refer to the DeltekSoftwareManager.pdf to learn more about DSM and how it works. 

https://deltek.custhelp.com/app/answers/detail/a_id/52469
https://dsm.deltek.com/DeltekSoftwareManager/Help/
https://dsm.deltek.com/DeltekSoftwareManager/Tutorial/PubData/Engine/Default.htm?https%3A%2F%2Fdsm.deltek.com%2FDeltekSoftwareManager%2FTutorial%2FPubData%2F
https://deltek.custhelp.com/app/answers/detail/a_id/52469
http://www.deltek.com/
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Field Name Description 

Username Enter your Support username. 

Password Enter your Support user password. 

If you have forgotten your username or password, click Account Assistance.  

If you have forgotten your username, enter your email address and click Email My Username.  

If you have forgotten your password, enter your username and click Reset My Password. 

3. On the Deltek Support Home Screen, click the Knowledge Center tab, complete the following 
fields, and then click Search: 

Field Name Description 

Refine by Product Select Costpoint from the drop-down list. 

Refine by 
Category/Version 

Expand Service Pack/Hot Fix in the drop-down list, and then select 
8.2 (GA). 

Search Type Use the default value, Phrases, or select your preferred search type 
from the drop-down list. 

Search by Keyword Enter the specific text that you are looking for or leave blank to return 
all records for this version. 

4. On the search results screen, perform the following actions: 

 In the Summary column, click the link for the desired correction. 

 When the desired correction loads, click the links in the Answers section to download the 
files. 

System Requirements 

Components 
Costpoint 8.2 uses the following components: 

 Database Tier: SQL Server 

 Application Tier: With integrated WebLogic Server 

 Browser Client: Edge, Chrome, Firefox, or Safari 

 Web Tier: Microsoft Internet Information Server (optional) 

System Clocks 
For the Costpoint system to function properly, the system clocks on your WebLogic application server and 
the database server that hosts your Costpoint databases must be synchronized with each other. Failure 
to synchronize your system clocks may result in login and other system problems. 
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Hardware Recommendations 
You should have received a hardware recommendations document. For future releases of Costpoint, 
hardware recommendations will be supplied via a Customer Care Knowledge Base article. 

Uninstalling and Reinstalling on the Same Server/VM 
Errors can occur when you uninstall and reinstall Costpoint on the same Server/VM. If you encounter 
problems during a first installation attempt and need to start over, Deltek recommends that you start over 
on a freshly built Server/VM.  

If you are using a VM, taking a snapshot of the VM before you begin the installation offers an easy 
method of returning to a fresh state. 

Compatibility Matrix 
For the most current hardware and software requirements, please refer to the Knowledge Base article 
containing the Compatibility Matrix: 

 https://deltek.custhelp.com/app/answers/detail/a_id/38499 

 https://deltek.custhelp.com/ci/fattach/get/1072689/0/filename/DeltekProductSupportCompatibility
Matrix.pdf 

Costpoint 8.2 Log File Information 
The table below provides information on the log files used by Costpoint 8.2. All these log files are located 
on the Application Server under the C:\Deltek\Costpoint\82\logs folder. 

File Name Description 

DEServer.log This log file is maintained by the WebLogic server instance. In a 
clustered environment, each server writes to a separate file and the 
filename matches the server name.  

The log records server-specific events such as the startup and 
shutdown of servers, the deployment of new applications, or the 
failure of one or more subsystems. The messages include the time 
and date of the event as well as the ID of the user who initiated the 
event. 

CP_DBConn_DEServer.log This file lists the activate connections used by the product at a 
given time.  

To enable this logging, set 
<SYSTEMNAME>.logDBConnectionProfile = true in enterprise 
properties.  

In a clustered environment, each server writes to a separate log file 
and the server name determines the name of the log file.  

CP_DBConn_<Server>.log 

CP_DEServer.log This file contains application-specific information such as 
performance, security, and errors encountered while running a 
Costpoint application.  

https://deltek.custhelp.com/app/answers/detail/a_id/38499
https://deltek.custhelp.com/app/answers/detail/a_id/38499
https://deltek.custhelp.com/ci/fattach/get/1072689/0/filename/DeltekProductSupportCompatibilityMatrix.pdf
https://deltek.custhelp.com/ci/fattach/get/1072689/0/filename/DeltekProductSupportCompatibilityMatrix.pdf
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File Name Description 
Each server writes to a separate log file and the server name 
determines the name of the log file.  

CP_<Server>.log 

CP_Security_DEServer.log This file captures messages generated by Costpoint Web security 
module. Messages such as invalid login attempts caused by 
problematic user IDs, passwords, or insufficient parameters, as well 
as deactivated user accounts, are captured here.  

In a clustered environment, each server writes to a separate log file 
and the server name determines the name of the log file.  

CP_Security_<Server>.log 

delteke.log This log file contains information that pertains to the entire domain. 
It consolidates log records from all application logs and a subset of 
events recorded in all server logs. All the information gathered is 
written into a single file.  

Not all log messages are written into domain. Only those messages 
that match the defined severity are consolidated. 

service.log This log file contains messages generated by Costpoint Web 
windows service. It helps in troubleshooting issues related to 
service startup, which usually occur during the initial configuration 
stages.  

In addition to service-related messages, this file contains most of 
the information that is captured in the DEServer.log.  

Therefore, after the initial startup issues are sorted out, Deltek 
recommends that you disable this log by editing 
InstallCPWebasService.cmd (C:\Deltek\Costpoint\82\bin folder) 
and removing the occurrence of:  

"-log:%CP_ROOT%\logs\service.log".  

If you remove this after installing the service, you will need to 
uninstall and reinstall the service for the changes to take effect. 
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Database Tier Installation 
This section provides instructions and recommendations for creating your Costpoint 8.2 Transaction, 
System, Admin, Planning Transaction, and Time & Expense Transaction database(s) and the 
corresponding Costpoint users and schemas. Deltek recommends using a single database to host all the 
Costpoint schemas. 

During this installation process, you will install the Costpoint 8.2 Database Tier software and automatically 
perform the following: 

 Create and populate a Costpoint 8.2 Transaction database schema to store transaction data.  

 Create and populate a Costpoint 8.2 System database schema to store metadata.  

 Create and populate a Costpoint 8.2 Admin database schema to store system and security 
information. 

 Create and populate a Costpoint 8.2 Planning Transaction database schema to store PL 
transaction data, if applicable. 

 Create and populate a Costpoint 8.2 Time & Expense Transaction database schema to store TE 
transaction data, if applicable.  

 

Before You Start 
Make sure that you meet all Database Tier Installation Prerequisites. 

Install Database Tier Software 
This section provides the steps for installing the Costpoint 8.2 Database Tier software and creating the 
Transaction, System, Admin, PL Transaction, and TE Transaction databases. 

You must perform these steps on your database server. 

 
You must have Internet access on the machine where the Costpoint 8.2 installer is invoked in order to 
download the latest DeltekCostpoint82DatabaseNewInstallationFiles.exe and 
DeltekCostpoint82RequirementsINI.exe files automatically.  

The DeltekCostpoint82DatabaseInstallationFiles.exe contains the latest special characters supported for 
user, password, and other fields in the installer as well as other files needed in the enable JDBC area. 
The DeltekCostpoint82RequirementsINI.exe contains the latest OS platforms and database versions 
supported. These files are automatically downloaded when you launch the Database Tier installation, 
assuming that your database server has Internet access.  

Note: The Costpoint Database Tier installer creates a SQL Server database user and corresponding 
schema with the same name. 

Note: For SQL Server cluster installations, the install directory must be a local drive as opposed to a 
shared drive. 
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If your database server does not have internet access, you must perform the steps in the Latest Installer 
Files Download Instructions section of this document before you run the 
DeltekCostpoint82DatabaseTier.exe file. 

To install the Database Tier software: 
1. Run the DeltekCostpoint82DatabaseTier_Buildxx.exe file to launch the Costpoint 8.2 

Database Tier installation program. 

 
2. On the Welcome to the InstallShield Wizard for Deltek Costpoint Database screen, click Next >.  

3. On the Select the Database Type screen, select Microsoft SQL Server, and click Next >.  

4. On the Choose Destination Location screen, click Browse to navigate to an installation location 
for the Costpoint 8.2 Database Tier software, and click Next >.  

The default installation location is C:\Deltek\Costpoint\82\Database\Scripts (recommended). 

5. On the Features screen, select from the following. 

Field Name Action 

Costpoint MSSQL 
Databases 

Select this feature to install and configure the Costpoint Transaction, 
System, and Admin databases and users. 

Time & Expense 
MSSQL Database 

Select this feature to install and configure the Time & Expense 
Transaction database and user. 

Planning MSSQL 
Database 

Select this feature to install and configure the Planning Transaction 
database and user. 

6. On the Costpoint SQL Server TRANSACTION Database Information screen, complete the 
following fields. 

Field Name Action 

IP Address or 
Hostname 

Enter the IP address (for example, 10.2.2.154) or hostname (for 
example, dbsvr01) of your Costpoint 8.2 Transaction (DELTEKCP) 
database server. The default value is your computer name. In addition 
to standard alphanumeric characters, the following special characters 
are also supported: 

- _ 

Note: The Deltek product installers contain functionality which enables them to dynamically download 
configuration files and patch rollback scripts when the product installers are executed from the Deltek 
Software Manager server. To improve security, these connections have been modified to require 
communication over HTTPS. 

Note: Due to enhanced security in Microsoft Windows Server, it is advised that you use the 
Run as Administrator option when launching installation files, even if you are logged in as a 
user with local administrative rights. To do so, right-click the 
DeltekCostpoint82DatabaseTier.exe file in Windows Explorer and select Run as 
Administrator. 
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Field Name Action 
The values for the IP Address or Hostname cannot be 127.0.1.0.1 or 
localhost. 
For SQL Cluster installations, you must specify the SQL Cluster IP 
Address or SQL Cluster Hostname. 

Instance Name Enter the name of your Costpoint Transaction database instance. The 
default value is LOCAL. In addition to standard alphanumeric 
characters, the following special characters are also supported: 

$ _ 

Port Enter the SQL Server TCP port for the Costpoint Transaction database 
server. The default port for SQL Server is 1433. 

Currently, this installer will allow database installations to connect to a 
SQL Server DEFAULT instance over port 1433 only. Use of non-default 
ports will be addressed in a future release. 

Transaction 
Database Name 

Enter the name of your Costpoint Transaction database. The default 
value is DELTEKCP. In addition to standard alphanumeric characters, 
the following special characters are also supported: 

$ _ 

Transaction 
Database User 

Enter the name of your Costpoint Transaction user account. The default 
is CPTRAN. The Costpoint Installer creates a SQL Server schema with 
the same name as the username. In addition to standard alphanumeric 
characters, the following special characters are also supported: 

$ _ 

Transaction 
Database User 
Password 

Enter the password for your Costpoint Transaction user account. In 
addition to standard alphanumeric characters, the following special 
characters are also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

Transaction 
Database Confirm 
User Password 

Re-enter the password for your Costpoint Transaction user account. In 
addition to standard alphanumeric characters, the following special 
characters are also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

MSSQL SA User Enter the name of your Microsoft SQL Server SA user. The default is 
sa. If a user with “sysadmin” privileges is available, that user can 
alternatively be used. In addition to standard alphanumeric characters, 
the following special characters are also supported: 

$ _ 

MSSQL SA User 
Password 

Enter the password for your Microsoft SQL Server SA user. In addition 
to standard alphanumeric characters, the following special characters 
are also supported: 
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Field Name Action 
‘ ~ # $ ^ & ( ) - _ + = , . 

7. Click Test Connection.  

If you entered the proper database connection information, a message similar to the following 
displays: 

“DELTEKCP Database and CPTRAN User will be created. Click Next.” 

If this message does not display, correct the connection information, and click Test Connection 
again.  

8. After receiving the message, click Next >. 

9. On the Costpoint SQL Server ADMIN Database Information screen, complete the following fields. 

Field Name Action 

IP Address or 
Hostname 

Enter the IP address (for example, 10.2.2.154) or hostname (for 
example, dbsvr01) of your Costpoint 8.2 Admin (DELTEKADM) 
database server. The default value is your computer name. In addition 
to standard alphanumeric characters, the following special characters 
are also supported: 

- _ 

The values for the IP Address or Hostname cannot be 127.0.1.0.1 or 
localhost. 
For SQL Cluster installations, you must specify the SQL Cluster IP 
Address or SQL Cluster Hostname. 

Instance Name Enter the name of your Costpoint Admin database instance. The default 
value is LOCAL. In addition to standard alphanumeric characters, the 
following special characters are also supported: 

$ _ 

Port Enter the SQL Server TCP port the Costpoint Admin database server. 
The default port for SQL Server is 1433. Currently, this installer will 
allow database installations to connect to a SQL Server DEFAULT 
instance over port 1433 only. Use of non-default ports will be 
addressed in a future release. 

Admin Database 
Name 

Enter the name of your Costpoint Admin database. The default value is 
DELTEKADM. In addition to standard alphanumeric characters, the 
following special characters are also supported: 

$ _ 

Admin Database 
User 

Enter the name of your Costpoint Admin user account. The default is 
CPADMIN. The Costpoint Installer creates a SQL Server schema with 
the same name as the username. In addition to standard alphanumeric 
characters, the following special characters are also supported: 

$ _ 
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Field Name Action 

Admin Database 
User Password 

Enter the password for your Costpoint Admin user account. In addition 
to standard alphanumeric characters, the following special characters 
are also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

Admin Database 
Confirm User 
Password 

Re-enter the password for your Admin user account. In addition to 
standard alphanumeric characters, the following special characters are 
also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

MSSQL SA User Enter the name of your Microsoft SQL Server SA user. The default is 
sa. If a user with “sysadmin” privileges is available, that user can 
alternatively be used. In addition to standard alphanumeric characters, 
the following special characters are also supported: 

$ _ 

MSSQL SA User 
Password 

Enter the password for your Microsoft SQL Server SA user. In addition 
to standard alphanumeric characters, the following special characters 
are also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

10. Click Test Connection.  

If you have entered the proper database connection information, a message similar to the 
following displays: 

“DELTEKADM Database and CPADMIN User will be created. Click Next.” 

If this message does not display, correct the connection information, and click Test Connection 
again.  

11. After receiving the message, click Next >. 

12. On the Costpoint SQL Server SYSTEM Database Information screen, complete the following 
fields. 

Field Name Action 

IP Address or 
Hostname 

Enter the IP address (for example, 10.2.2.154) or hostname (for 
example, dbsvr01) of your Costpoint 8.2 System (DELTEKSYS) 
database server. The default value is your computer name. In addition 
to standard alphanumeric characters, the following special characters 
are also supported: 

- _ 
The values for the IP Address or Hostname cannot be 127.0.1.0.1 or 
localhost. 
For SQL Cluster installations, you must specify the SQL Cluster IP 
Address or SQL Cluster Hostname. 
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Field Name Action 

Instance Name Enter the name of your Costpoint System database instance. The 
default value is LOCAL. In addition to standard alphanumeric 
characters, the following special characters are also supported: 

$ _ 

Port Enter the SQL Server TCP port the Costpoint database server. The 
default port for SQL Server is 1433. Currently, this installer will allow 
database installations to connect to a SQL Server DEFAULT instance 
over port 1433 only. Use of non-default ports will be addressed in a 
future release. 

System Database 
Name 

Enter the name of your Costpoint System database. The default value 
is DELTEKSYS. In addition to standard alphanumeric characters, the 
following special characters are also supported: 

$ _ 

System Database 
User 

Enter the name of your Costpoint System user account. The default is 
CPSYSTEM. The Costpoint Installer creates a SQL Server schema 
with the same name as the username. In addition to standard 
alphanumeric characters, the following special characters are also 
supported: 

$ _ 

System Database 
User Password 

Enter the password for your Costpoint System user account. In addition 
to standard alphanumeric characters, the following special characters 
are also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

System Database 
Confirm User 
Password 

Re-enter the password for your Costpoint System user account. In 
addition to standard alphanumeric characters, the following special 
characters are also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

MSSQL SA User Enter the name of your Microsoft SQL Server SA user. The default is 
sa. If a user with “sysadmin” privileges is available, that user can 
alternatively be used. In addition to standard alphanumeric characters, 
the following special characters are also supported: 

$ _ 

MSSQL SA User 
Password 

Enter the password for your Microsoft SQL Server SA user. In addition 
to standard alphanumeric characters, the following special characters 
are also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

13. Click Test Connection.  

If you entered the proper database connection information, a message similar to the following 
displays: 
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“DELTEKSYS Database and CPSYSTEM User will be created. Click Next.” 

If this message does not display, correct the connection information, and click Test Connection 
again.  

14. After receiving the message, click Next >. 

15. On the Time & Expense SQL Server TRANSACTION Database Information screen, complete the 
following fields. 

Field Name Action 

IP Address or 
Hostname 

Enter the IP address (for example, 10.2.2.154) or hostname (for 
example, dbsvr01) of your Time & Expense 8.2 Transaction 
(DELTEKTE) database server. The default value is your computer 
name. In addition to standard alphanumeric characters, the following 
special characters are also supported: 

- _ 

The values for the IP Address or Hostname cannot be 127.0.1.0.1 or 
localhost. 
For SQL Cluster installations, you must specify the SQL Cluster IP 
Address or SQL Cluster Hostname. 

Instance Name Enter the name of your Time & Expense Transaction database 
instance. The default value is LOCAL. In addition to standard 
alphanumeric characters, the following special characters are also 
supported: 

$ _ 

Port Enter the SQL Server TCP port for the Time & Expense Transaction 
database server. The default port for SQL Server is 1433. Currently, 
this installer will allow database installations to connect to a SQL Server 
DEFAULT instance over port 1433 only. Use of non-default ports will be 
addressed in a future release. 

Transaction 
Database Name 

Enter the name of your Time & Expense Transaction database. The 
default value is DELTEKTE. In addition to standard alphanumeric 
characters, the following special characters are also supported: 

$ _ 

Transaction 
Database User 

Enter the name of your Time & Expense Transaction user account. The 
default is TETRAN. The installer creates a SQL Server schema with the 
same name as the username. In addition to standard alphanumeric 
characters, the following special characters are also supported: 

$ _ 

Transaction 
Database User 
Password 

Enter the password for your Time & Expense Transaction user account.  
In addition to standard alphanumeric characters, the following special 
characters are also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 
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Field Name Action 

Transaction 
Database Confirm 
User Password 

Re-enter the password for your Time & Expense Transaction user 
account. In addition to standard alphanumeric characters, the following 
special characters are also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

MSSQL SA User Enter the name of your Microsoft SQL Server SA user. The default is 
sa. If a user with “sysadmin” privileges is available, that user can 
alternatively be used. In addition to standard alphanumeric characters, 
the following special characters are also supported: 

$ _ 

MSSQL SA User 
Password 

Enter the password for your Microsoft SQL Server SA user. In addition 
to standard alphanumeric characters, the following special characters 
are also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

16. Click Test Connection.  

If you entered the proper database connection information, a message similar to the following 
displays: 

“DELTEKTE Database and TETRAN User will be created. Click Next.” 

If this message does not display, correct the connection information, and click Test Connection 
again.  

17. After receiving the message, click Next >. 

18. On the Planning SQL Server TRANSACTION Database Information screen, complete the 
following fields. 

Field Name Action 

IP Address or 
Hostname 

Enter the IP address (for example, 10.2.2.154) or hostname (for 
example, dbsvr01) of your Planning 8.2 Transaction (DELTEKPL) 
database server. The default value is your computer name. In addition 
to standard alphanumeric characters, the following special characters 
are also supported: 

- _ 

The values for the IP Address or Hostname cannot be 127.0.1.0.1 or 
localhost. 
For SQL Cluster installations, you must specify the SQL Cluster IP 
Address or SQL Cluster Hostname. 

Instance Name Enter the name of your Planning Transaction database instance. The 
default value is LOCAL. In addition to standard alphanumeric 
characters, the following special characters are also supported: 

$ _ 
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Field Name Action 

Port Enter the SQL Server TCP port the Planning Transaction database 
server. The default port for SQL Server is 1433. Currently, this installer 
will allow database installations to connect to a SQL Server DEFAULT 
instance over port 1433 only. Use of non-default ports will be 
addressed in a future release. 

Transaction 
Database Name 

Enter the name of your Planning Transaction database. The default 
value is DELTEKPL. In addition to standard alphanumeric characters, 
the following special characters are also supported: 

$ _ 

Transaction 
Database User 

Enter the name of your Planning Transaction user account. The default 
is PLTRAN. The Costpoint Installer creates a SQL Server schema with 
the same name as the username. In addition to standard alphanumeric 
characters, the following special characters are also supported: 

$ _ 

Transaction 
Database User 
Password 

Enter the password for your Planning Transaction user account. In 
addition to standard alphanumeric characters, the following special 
characters are also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

Transaction 
Database Confirm 
User Password 

Re-enter the password for your Planning Transaction user account. In 
addition to standard alphanumeric characters, the following special 
characters are also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

MSSQL SA User Enter the name of your Microsoft SQL Server SA user. The default is 
sa. If a user with “sysadmin” privileges is available, that user can 
alternatively be used. In addition to standard alphanumeric characters, 
the following special characters are also supported: 

$ _ 

MSSQL SA User 
Password 

Enter the password for your Microsoft SQL Server SA user. In addition 
to standard alphanumeric characters, the following special characters 
are also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

19. Click Test Connection.  

If you have entered the proper database connection information, a message similar to the 
following displays: 

“DELTEKPL Database and PLTRAN User will be created. Click Next.” 

If this message does not display, correct the connection information, and click Test Connection 
again.  

20. After receiving the message, click Next >. 
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21. On the Link User Information screen, complete the following fields: 

Field Name Action 

Link User Name Enter the name of your LINK user account. The default value is 
CPLINK_USER. The Link username must be unique for each and every 
Costpoint system you configure. In addition to standard alphanumeric 
characters, the following special characters are also supported: 

$ _ 

Link User 
Password 

Enter the password for your LINK user account. In addition to standard 
alphanumeric characters, the following special characters are also 
supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

Link User Confirm 
Password 

Re-enter the password for your LINK user account. In addition to 
standard alphanumeric characters, the following special characters are 
also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

22. Click Test Connection.  

If you have entered the proper database connection information, a message similar to the 
following displays: 

“User CPLINK_USER will be created. Click Next.”  

If the message does not display, correct the connection information, and click Test Connection 
again. 

23. After receiving the message, click Next >. 

24. On the Start Copying Files screen, review the installation parameters that you selected: 

 If you want to change any settings, click < Back and make the necessary changes.  

 If you are satisfied with these settings, click Install > to begin the installation. 

Once initiated, the installation process will commence and create objects needed for Costpoint 
8.2. Do not interrupt the process. A Windows Command Prompt will appear on your screen that 
displays the scripts that are being executed. 

The installation will perform the scenarios detailed in the Installation Process for Costpoint 8.2 
section of this document. The installation process will stop if any errors are encountered. If any 
errors occur during the installation, please contact Deltek Technical Support. 

25. Upon completion, the Deltek Costpoint Database - Installation Summary Results screen displays 
the results of the installation process.  

For each Feature you selected to install, you should see a SUCCESS message. 

Any FAILED messages or Errors indicated should be further researched in the applicable detailed 
log file(s) and reported to Deltek Costpoint Technical Support. 

26. Click Next >. 

27. On the InstallShield Wizard Complete screen, complete the following fields. 
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Field Name Action 

Launch the 
installer 
summary file 

Select this checkbox to review the summary log file. This will show the 
same data from previous screen. C:\Program Files\Deltek\Costpoint\ 
8.2\Logs\DBTier_Installer\DBTier_Install_SummaryResults.log. 

Launch the 
installer log file 

Select this checkbox to review the Deltek Costpoint Database installer log 
file. C:\Program Files\Deltek\Costpoint\8.2\Logs\DBTier_Installer\ 
DBTier_Install.log. 

28. Click Finish to exit the installation. 

Please review all log files for any Errors or reported issues, although to help identify any 
issues, all Errors will be in the DBTier_Install_ErrorSummaryResults.log, from the 
C:\Program Files\Deltek\Costpoint\8.2\Logs\DBTier_Installer folder. 
The following errors can be ignored in the DBTier_Install.log. 
AppendFileToLogFile - Sqlcmd: Error: Microsoft SQL Server Native Client 11.0 : 
SQL Server Network Interfaces: Connection string is not valid [87]. . 

AppendFileToLogFile - Sqlcmd: Error: Microsoft SQL Server Native Client 11.0 : 
Login timeout expired. 

AppendFileToLogFile - Sqlcmd: Error: Microsoft SQL Server Native Client 11.0 : 
A network-related or instance-specific error has occurred while establishing a 
connection to SQL Server. Server is not found or not accessible. Check if 
instance name is correct and if SQL Server is configured to allow remote 
connections. For more information see SQL Server Books Online. 

Make sure that the default SQL Server Port, 1433, is open for Inbound and Outbound traffic 
through your firewall. Also, make sure that Network Discovery and File Sharing options are 
switched on. 
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Enable JDBC Distributed Transactions  
Complete the configuration and setup instructions based on your implementation: 

 If the installer is executed on the database server and all user(s)/schema(s) (TRANSACTION, 
SYSTEM (Meta), ADMIN, TE TRANSACTION, and PL TRANSACTION) were created on a single 
instance, you are not required to perform any additional steps to enable distributed transactions. 
All required steps were performed during Costpoint Database Tier installation. This is the most 
common and simple implementation for most clients. You can proceed to the application tier 
installation. 

 If the installer is executed on the database server with database(s)/user(s)/schema(s) configured 
across different instances within the same server, the following set of actions must be performed 
for each instance where Costpoint schema(s)/database(s) are configured. Complete the steps in 
the next section, “How to Enable JDBC Distributed Transactions and XA Using Costpoint Installer 
for an Instance.” 

 If the installer is executed from an alternative database server or from a client connectivity tools 
desktop with the actual databases residing remotely on a database server, complete the steps in 
the next section “How to Enable JDBC Distributed Transactions and XA Using Costpoint Installer 
for an Instance.”  

 If Costpoint is set up across different database servers and instances with each database 
remotely configured for TRANSACTION, SYSTEM (Meta), ADMIN, TE TRANSACTION, and PL 
TRANSACTION, complete the steps in the “How to Enable JDBC Distributed Transaction and XA 
for Remote Database Servers” section. 

 If Costpoint is set up using SQL Cluster configuration, complete the steps in the “How to Enable 
JDBC Distributed Transaction and XA for SQL Cluster Configuration” section. 

How to Enable JDBC Distributed Transactions and XA Using 
Costpoint Installer for an Instance 
To enable JDBC and XA using Costpoint Installer: 

1. Create a backup of your Microsoft SQL Server master database. 

2. Copy the DeltekCostpoint82DatabaseTier.exe installation file to this database server where 
Costpoint databases are created. 

3. Run the DeltekCostpoint82DatabaseTier_Buildxx.exe /enableXA command to launch the 
Costpoint Database Tier enable XA program.  

4. On the Microsoft SQL Server for Deltek Costpoint 8.2 Database Information screen, complete the 
following fields. 

Field Name Action 

IP Address or 
Hostname 

Enter the IP address (for example, 10.2.2.154) or hostname (for example, 
dbsvr01) of your Costpoint 8.2 
DELTEKCP/DELTEKSYS/DELTEKADM/DELTEKTE/DELTEKPL database 
server. The default value is your computer name. In addition to standard 
alphanumeric characters, the following special characters are also 
supported: 

- _ 
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Field Name Action 
The value entered in the IP Address or Hostname field cannot be 
127.0.1.0.1 or localhost. 
For SQL Cluster installations, you must specify the SQL Cluster Hostname. 

Port Enter the port that your Costpoint 8.2 database server software uses to 
listen for requests. The default port for Microsoft SQL Server is 1433. 

Instance Name Enter the name of your Costpoint 8.2 database instance used during new 
install setup. The default value is LOCAL. In addition to standard 
alphanumeric characters, the following special characters are also 
supported: 

$ _ 

SA User Enter the name of your Microsoft SQL Server SA user. The default is sa. In 
addition to standard alphanumeric characters, the following special 
characters are also supported: 

$ _ 

If a user with “sysadmin” privileges is available, that user can alternatively 
be used. 

SA Password Enter the password for your Microsoft SQL Server SA user. In addition to 
standard alphanumeric characters, the following special characters are also 
supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

5. Click Test Connection.  

If you have entered the proper database connection information, the following message displays:  

“Connection Successful. Click Next.”  

If this message does not display, correct the information entered, and click Test Connection 
again.  

6. After receiving the confirmation message, click Next > to begin the installation process. 

The Restarting the Distributed Transaction Coordinator (MSDTC) Service window will display as 
part of the installation process. 

If any errors occur during this step, please call Deltek Costpoint Technical Support. 

7. Click OK when the following message displays: “Successfully configured XA transactions.”  

 

Note: If your Costpoint 8.2 TRANSACTION, SYSTEM, ADMIN, TE TRANSACTION, and PL 
TRANSACTION databases reside on different servers, you must perform all the actions in this step 
against each of the other servers. 
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How to Enable JDBC Distributed Transaction and XA for 
Remote Database Servers 
If your Costpoint TRANSACTION, SYSTEM, ADMIN, TE TRANSACTION, and PL TRANSACTION 
databases reside on different database servers, you must perform this step in each of the servers. 

An example for this configuration is shown below: 

 

 
 

Based on the configuration above, you should complete all steps documented to enable distributed 
transaction on both Server A and Server B. 

To enable JDBC and XA for remote database servers: 
1. Perform this step for the database instance using the instructions on How to Enable JDBC 

Distributed Transactions and XA Using Costpoint Installer for an Instance. 

The sequence of steps to open Component Services on your server might be different based on 
your Windows OS version. 

2. On the left navigator tree, click Component Services » Computers » My Computer » 
Distributed Transaction Coordinator. 

3. Right-click Local DTC and click Properties on the shortcut menu. 

4. Click the Security tab. 

5. Perform the following: 

 Under Security Settings, select Network DTC Access. 

 Under Client and Administration, select Allow Remote Clients. 

 Under Transaction Manager Communication, select Allow Inbound and Allow 
Outbound. 

 Select the No Authentication Required option. 

 Select XA Transactions. 

DBServer A (Instance LOCAL) 

    DELTEKCP (Transaction DB) 

    CPADMIN (Admin DB) 

DBServer B (Instance LOCAL) 

    CPSYSTEM (Meta DB) 
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6. Click Apply.  

The following message displays: 

“The MSDTC Service will be stopped and restarted. All dependent services will be stopped. 
Applications using MSDTC may need to be restarted to use the new settings.” 

7. Click Yes. 

The following message displays: “The MSDTC service has been restarted.”  

8. Click OK. 

Your screen should look similar to the following. 

 

 
9. If your database server is configured for Windows Firewall, for DTC to function, follow the 

necessary firewall settings for MSDTC program. 

a. Click Start » Control Panel. 
b. In the search box, enter firewall, and click Windows Firewall. 
c. In the left pane, click Allow a program or feature through Windows Firewall. 
d. Click Change settings.  

Note: For DTC to function correctly, each of the hosts participating should be resolvable by 
NetBIOS name and each remote host should be reachable by name. This function will not 
work if the host server is configured only by IP address (as in many VM test deployments). 
In such cases, either have your host added to the IP/hostname mappings in your 
“c:\Windows\System32\drivers\etc\hosts” file or if in a domain, add DNS aliases. 
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e. If you are prompted for an administrator password or confirmation, enter the password or 
provide confirmation. 

f. Select the checkbox next to Distributed Transaction Coordinator for both Private and 
Public, and click OK. 

A sample selection of firewall setting for DTC program is shown below: 

 
10. Reboot the server. 

11. Repeat steps 1 through 4 for each of the servers. 

In the sample configuration, these steps would be repeated for “DBServer A” and “DBServer B.” 

12. Proceed to the Application Tier Installation section. 

How to Enable JDBC Distributed Transaction and XA for SQL 
Cluster Configuration 
If your Costpoint TRANSACTION, SYSTEM, ADMIN, TE TRANSACTION, and PL TRANSACTION 
databases reside on a SQL Cluster configuration, complete following the instructions. 

To enable JDBC and XA for SQL Cluster configuration: 
1. Perform this step on the database cluster instance on each node, using the instructions provided 

in the section How to Enable JDBC Distributed Transactions and XA Using Costpoint Installer for 
an Instance. 

The sequence of steps to open Component Services on your server might be different based on 
your Windows OS version. 

2. On the left navigator tree, click Component Services » Computers » My Computer » 
Distributed Transaction Coordinator » Clustered DTCs. 
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3. Right-click your configured Distributed Transaction Coordinator Service Name (for example, 

DELTEKCPDTC), and click Properties on the shortcut menu. 

4. On the Security tab, select XA Transactions. 

5. Click Apply.  

The following message displays: 

“The MSDTC Service will be stopped and restarted. All dependent services will be stopped. 
Applications using MSDTC may need to be restarted to use the new settings.” 

6. Click Yes.  

The following message displays: “The MSDTC service has been restarted.”  

7. Reboot the server. 

8. Repeat for each node participating in the cluster and proceed to the Application Tier Installation 
section. 

Note: If you do not see the Clustered DTCs section, you may need to move the DTC Service 
to this node to make this visible. Please reopen Component Services after moving the DTC 
service to this node.  

While the product may be functional by setting these properties on the active node during 
initial installation, it is important that all these steps are done in all nodes so that when the 
SQL Cluster services failover to alternate available nodes, the DTC function performs 
distributed transactions for proper application behavior. 
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Application Tier Installation 
The Costpoint 8.2 system uses Oracle’s WebLogic Server for its application server tier. During the 
Application Tier installation process, you will install the WebLogic Server 14.1.1 application server 
software and the Costpoint 8.2 software. The Costpoint 8.2 WebLogic application server must not contain 
any previous versions of WebLogic. 

Before You Start 
Make sure that you meet all Application Tier Installation Prerequisites. 

Install Application Tier Software 
This section provides instructions for installing Oracle’s WebLogic Server 14.1.1 application server 
software and Deltek Costpoint 8.2 software. You must perform these steps on the machine that will serve 
as your Costpoint 8.2 application server. 

You must have Internet access on the machine where the Costpoint 8.2 installer is invoked in order to 
download the latest DeltekCostpoint82RequirementsINI.exe file automatically. The file contains the latest 
OS platforms and database versions supported. If the server has Internet access, the file is automatically 
downloaded when you launch the Application Tier installation. 

 
If your application server does not have internet access, you need to perform the steps in the Latest 
Installer Files Download Instructions section of this document before you run the 
DeltekCostpoint82ApplicationTier_Buildxx.exe file. 

To install the Application Tier software: 
1. Run the DeltekCostpoint82ApplicationTier_Buildxx.exe file to launch the Costpoint 8.2 

Application Tier installation program.   

 
2. On the Welcome to the InstallShield Wizard for Deltek Costpoint Application screen, click Next >. 

3. On the Setup Type screen, complete the following fields, and click Next >. 

Field Name Action 

Primary Application 
Server Tier 

Select this setup type to install both the Oracle WebLogic and Deltek 
Costpoint Application Tier software. This option must be selected if 
you are installing Costpoint in a non-clustered environment or if this 
will be your Primary Application Server Tier in a clustered 
environment. 

Note: The Deltek product installers contain functionality which enables them to dynamically download 
configuration files and patch rollback scripts when the product installers are executed from the Deltek 
Software Manager server. To improve security, these connections have been modified to require 
communication over HTTPS. 

Note: Due to enhanced security in Microsoft Windows Server, it is advised that you use the 
Run as Administrator option when launching installation files, even if you are logged in as a 
user with local administrative rights. 



Application Tier Installation 

Microsoft SQL Server 33 

 

Field Name Action 
Additional changes are required to configure a clustered environment. 

Secondary 
Application Server 
Tier 

Select this setup type to install only the Oracle WebLogic software. 
The Deltek Costpoint Application Tier software will not be installed.  

This option must only be selected when configuring a clustered 
environment after your Primary Application Server Tier has already 
been installed. 

4. On the Feature Selection screen, complete the following fields, and click Next >. 

Field Name Action 

Costpoint This feature is automatically selected for you. All variations still require 
Costpoint schema information to be entered. 

Time & Expense Select this feature if you have purchased Time & Expense. 

Planning Select this feature if you have purchased Planning. 

5. On the Oracle WebLogic Installation Directory screen, click Browse… to navigate to an 
installation location for the Oracle WebLogic software, and click Next >.  

The default is C:\Oracle\Middleware14.1.1 (recommended). Do not install the WebLogic Server 
software in a directory path or folder that contains a space. The Costpoint 8.2 software will not 
function properly if the WebLogic Server software is installed to a directory path or folder that 
contains a space.  

6. If you select Secondary Application Server Tier for the Setup Type, the Pre-Installation 
Summary screen displays, so proceed to step 29 of this procedure. 

7. On the Choose Deltek Costpoint Application Installation Directory screen, navigate to the location 
where you want the Costpoint 8.2 software installed, and click Next >.  

The default directory is C:\Deltek (recommended). 

The directory in which you install the Costpoint 8.2 software cannot be the Oracle WebLogic 
install directory (C:\Oracle\Middleware14.1.1). 

 
8. On the Deltek Costpoint Application License screen, click the Browse… button, navigate to the 

folder containing your Costpoint, Time & Expense, and Planning license(s), select all applicable 
licenses, click Open, and then click Next >. 

Example license files: 

Deltek_CP_8_License CP.zip, Deltek_CP_8_License TE.zip, Deltek_CP_8_License PL.zip 
9. On the Select the Database Type screen, select Microsoft SQL Server, and click Next >.  

Note: If you choose to install to a different drive, Deltek strongly recommends that you use 
the same Deltek default directory (E:\Deltek). 
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10. On the Costpoint SQL Server TRANSACTION Database Information screen, complete the 
following fields. 

Field Name Action 

IP Address or 
Hostname 

Enter the IP address (for example, 10.2.2.154) or hostname (for 
example, dbsvr01) of your Costpoint 8.2 Transaction (DELTEKCP) 
database server. The default value is your computer name. In addition 
to standard alphanumeric characters, the following special characters 
are also supported: 

- _ 

The IP Address or Hostname cannot be 127.0.1.0.1 or localhost. 
For RAC installations, you must specify the IP Address or Hostname of 
one of the instances. Do not use the Virtual IP Address. 

Instance Name Enter the name of your Costpoint 8.2 Transaction (DELTEKCP) 
database instance. The default value is local. In addition to standard 
alphanumeric characters, the following special characters are also 
supported: 

$ _ 

Port Enter the port that your Costpoint 8.2 Transaction database server 
software uses to listen for requests. The default port for SQL Server is 
1433. 

Transaction 
Database Name 

Enter the name of your Costpoint 8.2 Transaction (DELTEKCP) 
database. The default value is DELTEKCP. In addition to standard 
alphanumeric characters, the following special characters are also 
supported: 

$ _ 

Transaction 
Database User 

Enter the name of your CPTRAN user. The default is CPTRAN. In 
addition to standard alphanumeric characters, the following special 
characters are also supported: 

$ _ 

Transaction 
Database User 
Password 

Enter the password for your CPTRAN user. In addition to standard 
alphanumeric characters, the following special characters are also 
supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

MSSQL SA User Enter the name of your Microsoft SQL Server SA user. The default is 
sa. In addition to standard alphanumeric characters, the following 
special characters are also supported: 

$ _ 

MSSQL SA User 
Password 

Enter the password for your Microsoft SQL Server SA user. In addition 
to standard alphanumeric characters, the following special characters 
are also supported: 
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Field Name Action 
‘ ~ # $ ^ & ( ) - _ + = , . 

11. Click Test Connection.  

If you have entered the proper database connection information, the following message displays: 
“Connection Successful. Click Next.”  

If it this message does not display, correct the information, and click Test Connection again.  

12. After you receive the message, click Next >.  

13. On the Costpoint SQL Server ADMIN Database Information screen, complete the following fields. 

Field Name Action 

IP Address or 
Hostname 

Enter the IP address (for example, 10.2.2.154) or hostname (for 
example, dbsvr01) of your Costpoint 8.2 Admin (DELTEKADM) 
database server. The default value is your computer name. In addition 
to standard alphanumeric characters, the following special characters 
are also supported: 

- _ 

The IP Address or Hostname cannot be 127.0.1.0.1 or localhost. 
For RAC installations, you must specify the IP Address or Hostname of 
one of the instances. Do not use the Virtual IP Address. 

Instance Name Enter the name of your Costpoint 8.2 Admin (DELTEKADM) database 
instance. The default value is local. In addition to standard 
alphanumeric characters, the following special characters are also 
supported: 

$ _ 

Port Enter the port that your Costpoint 8.2 Admin database server software 
uses to listen for requests. The default port for SQL Server is 1433. 

Admin Database 
Name 

Enter the name of your Costpoint 8.2 Admin (DELTEKADM) database. 
The default value is DELTEKADM. In addition to standard 
alphanumeric characters, the following special characters are also 
supported: 

$ _ 

Admin Database 
User 

Enter the name of your CPADMIN user. The default is CPADMIN. In 
addition to standard alphanumeric characters, the following special 
characters are also supported: 

$ _ 

Admin Database 
User Password 

Enter the password for your CPADMIN user. In addition to standard 
alphanumeric characters, the following special characters are also 
supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 
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Field Name Action 

MSSQL SA User Enter the name of your Microsoft SQL Server SA user. The default is 
sa. In addition to standard alphanumeric characters, the following 
special characters are also supported: 

$ _ 

MSSQL SA User 
Password 

Enter the password for your Microsoft SQL Server SA user. In addition 
to standard alphanumeric characters, the following special characters 
are also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

14. Click Test Connection.  

If you have entered the proper database connection information, the following message displays: 
“Connection Successful. Click Next.”  

If it this message does not display, correct the information entered, and click Test Connection 
again.  

15. After you receive the message, click Next >.  

16. On the Costpoint SQL Server SYSTEM Database Information screen, complete the following 
fields: 

Field Name Action 

IP Address or 
Hostname 

Enter the IP address (for example, 10.2.2.154) or hostname (for 
example, dbsvr01) of your Costpoint 8.2 System (DELTEKSYS) 
database server. The default value is your computer name. In addition 
to standard alphanumeric characters, the following special characters 
are also supported: 

- _ 

The IP Address or Hostname cannot be 127.0.1.0.1 or localhost. 
For RAC installations, you must specify the IP Address or Hostname of 
one of the instances. Do not use the Virtual IP Address. 

Instance Name Enter the name of your Costpoint 8.2 System (DELTEKSYS) database 
instance. The default value is local. In addition to standard 
alphanumeric characters, the following special characters are also 
supported: 

$ _ 

Port Enter the port that your Costpoint 8.2 System database server software 
uses to listen for requests. The default port for SQL Server is 1433. 

System Database 
Name 

Enter the name of your Costpoint 8.2 System (DELTEKSYS) database. 
The default value is DELTEKSYS. In addition to standard alphanumeric 
characters, the following special characters are also supported: 

$ _ 
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Field Name Action 

System Database 
User 

Enter the name your CPSYSTEM user. The default user is 
CPSYSTEM. In addition to standard alphanumeric characters, the 
following special characters are also supported: 

$ _ 

System Database 
User Password 

Enter the password for your CPSYSTEM user. In addition to standard 
alphanumeric characters, the following special characters are also 
supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

MSSQL SA User Enter the name of your Microsoft SQL Server SA user. The default is 
sa. In addition to standard alphanumeric characters, the following 
special characters are also supported: 

$ _ 

MSSQL SA User 
Password 

Enter the password for your Microsoft SQL Server SA user. In addition 
to standard alphanumeric characters, the following special characters 
are also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

17. Click Test Connection.  

If you have entered the proper database connection information, the following message displays: 
“Connection Successful. Click Next.”  

If it this message does not display, correct the information entered, and click Test Connection 
again.  

18. After you receive the message, click Next >.  

19. On the Time & Expense SQL Server TRANSACTION Database Information screen, complete the 
following fields. 

Field Name Action 

IP Address or 
Hostname 

Enter the IP address (for example, 10.2.2.154) or hostname (for 
example, dbsvr01) of your Time & Expense 8.2 Transaction 
(DELTEKTE) database server. The default value is your computer 
name. In addition to standard alphanumeric characters, the following 
special characters are also supported: 

- _ 

The IP Address or Hostname cannot be 127.0.1.0.1 or localhost. 
For RAC installations, you must specify the IP Address or Hostname 
of one of the instances. Do not use the Virtual IP Address. 

Instance Name Enter the name of your Time & Expense 8.2 Transaction (DELTEKTE) 
database instance. The default value is local. In addition to standard 
alphanumeric characters, the following special characters are also 
supported: 
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Field Name Action 
$ _ 

Port Enter the port that your Time & Expense 8.2 Transaction database 
server software uses to listen for requests. The default port for SQL 
Server is 1433. 

Transaction 
Database Name 

Enter the name of your Time & Expense 8.2 Transaction (DELTEKTE) 
database. The default value is DELTEKTE. In addition to standard 
alphanumeric characters, the following special characters are also 
supported: 

$ _ 

Transaction 
Database User 

Enter the name of your TETRAN user. The default is TETRAN. In 
addition to standard alphanumeric characters, the following special 
characters are also supported: 

$ _ 

Transaction 
Database User 
Password 

Enter the password for your TETRAN user. In addition to standard 
alphanumeric characters, the following special characters are also 
supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

MSSQL SA User Enter the name of your Microsoft SQL Server SA user. The default is 
sa. In addition to standard alphanumeric characters, the following 
special characters are also supported: 

$ _ 

MSSQL SA User 
Password 

Enter the password for your Microsoft SQL Server SA user. In addition 
to standard alphanumeric characters, the following special characters 
are also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

20. Click Test Connection.  

If you have entered the proper database connection information, the following message displays: 
“Connection Successful. Click Next.”  

If it this message does not display, correct the information entered, and click Test Connection 
again.  

21. After you receive the message, click Next >.  

22. On the Planning SQL Server TRANSACTION Database Information screen, complete the 
following fields. 

Field Name Action 

IP Address or 
Hostname 

Enter the IP address (for example, 10.2.2.154) or hostname (for 
example, dbsvr01) of your Planning 8.2 Transaction (DELTEKPL) 
database server. The default value is your computer name. In addition 
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Field Name Action 
to standard alphanumeric characters, the following special characters 
are also supported: 

- _ 

The IP Address or Hostname cannot be 127.0.1.0.1 or localhost. 
For RAC installations, you must specify the IP Address or Hostname 
of one of the instances. Do not use the Virtual IP Address. 

Instance Name Enter the name of your Planning 8.2 Transaction (DELTEKPL) 
database instance. The default value is local. In addition to standard 
alphanumeric characters, the following special characters are also 
supported: 

$ _ 

Port Enter the port that your Planning 8.2 Transaction database server 
software uses to listen for requests. The default port for SQL Server is 
1433. 

Transaction 
Database Name 

Enter the name of your Planning 8.2 Transaction (DELTEKPL) 
database. The default value is DELTEKPL. In addition to standard 
alphanumeric characters, the following special characters are also 
supported: 

$ _ 

Transaction 
Database User 

Enter the name of your PLTRAN user. The default is PLTRAN. In 
addition to standard alphanumeric characters, the following special 
characters are also supported: 

$ _ 

Transaction 
Database User 
Password 

Enter the password for your PLTRAN user. In addition to standard 
alphanumeric characters, the following special characters are also 
supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

MSSQL SA User Enter the name of your Microsoft SQL Server SA user. The default is 
sa. In addition to standard alphanumeric characters, the following 
special characters are also supported: 

$ _ 

MSSQL SA User 
Password 

Enter the password for your Microsoft SQL Server SA user. In addition 
to standard alphanumeric characters, the following special characters 
are also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

23. Click Test Connection.  

If you have entered the proper database connection information, the following message displays: 
“Connection Successful. Click Next.”  
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If it this message does not display, correct the information entered, and click Test Connection 
again.  

24. After you receive the message, click Next >.  

25. On the Link User Information screen, complete the following fields: 

Field Name Action 

Link User Name Enter the name your LINK user account. The default user is 
CPLINK_USER. In addition to standard alphanumeric characters, the 
following special characters are also supported: 

$ _ 

Link User 
Password 

Enter the password for your LINK user account. In addition to standard 
alphanumeric characters, the following special characters are also 
supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

26. Click Test Connection.  

If you have entered the proper database connection information, the following message displays:  

“Connection Successful. Click Next.”  

If it this message does not display, correct the information entered, and click Test Connection 
again.  

27. After receiving the message, click Next >.  

28. On the Deltek Costpoint Application System Information screen displays, complete the following 
fields, and click Next >. 

Field Name Action 

System Name Enter the system name that will be used to log on to the Costpoint 8.2 
system.  

Deltek recommends that you use your Costpoint 8.2 database name, 
DELTEKCP. 

The characters used for the system name must be uppercase and 
alphanumeric. It must not contain any special characters and must be 16 
characters or less in length. 

Listen Port Enter the port that your Application Server will use to listen for 
connections. The default value is 7009. 

29. On the Pre-Installation Summary screen, review the installation parameters you have selected: 

 If you want to change any settings, click < Back to go back and make the necessary 
changes.  

 If you are satisfied with these settings, click Install > to begin the installation. 

Once initiated, the installation process can take a long time to complete. Please do not interrupt 
the process. A Windows Command Prompt will also appear on your screen that displays the 
scripts that are being executed. 
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The installation will perform the scenarios detailed in the Installation Process for Costpoint 8.2, 
Application Tier Installation section of this document. The installation process will stop if any 
errors are encountered. If any errors occur during the installation, please contact Deltek Technical 
Support. 

30. Upon completion, the Deltek Costpoint Application Install Summary Results screen displays the 
results of the installation process.  

For each Feature you selected to install, you should see a SUCCESS message. 

Any FAILED messages or Errors indicated should be further researched in the applicable detailed 
log file(s) and reported to Deltek Costpoint Technical Support. 

31. Click Next >. 

32. On the InstallShield Wizard Complete screen, complete the following fields. 

Field Name Action 

Launch the 
installer summary 
file 

Select this checkbox to review the summary log file. This displays the 
same data from previous screen.  

Launch the 
installer log file 

Select this checkbox to review the Deltek Costpoint Application installer 
log file. 

33. Click Finish to exit the installation. 

Please review all log files for any Errors or reported issues. Although to help identify any 
issues, all Errors will be in the AppTier_Install_ErrorSummaryResults.log, from the 
C:\Program Files\Deltek\Costpoint\8.2\Logs\AppTier_Installer folder. 
Make sure that your default Application Server Listener Port (7009) is open for Inbound and 
Outbound traffic through your firewall. Also, make sure that Network discovery and File Sharing 
options are switched on. 

 

Add Users to the CostpointToolsGroup 
This section provides the steps you complete to add the necessary users to the newly created User 
Group, CostpointToolsGroup.  

The Application Tier installation that you just completed added this group to your application server, 
granting it the following: 

 Full Sharing and Full Security Permissions to the C:\Deltek folder  

 Full Security Permissions to the C:\Oracle\Middleware14.1.1 folder 

Note: If you are running a WebLogic cluster, you must repeat this step for all of your WebLogic 
servers.  

Run the step once on your Cluster master and choose Primary Application Server Tier for the 
Costpoint Tier Type. Then, on each of your cluster nodes, choose Secondary Application Server 
Tier for the Costpoint Tier Type.  

Please refer to the DeltekCostpoint82ConfigurationUtility.pdf technical guide for more information 
on WebLogic clustering. 
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You must perform this procedure on your Costpoint 8.2 application server. 

To add users to the newly created CostpointToolsGroup: 
1. Open Computer Management.  
2. From Computer Management » Local Users and Groups » Groups, add the following users to 

the CostpointToolsGroup group: 

 Web Tier (IIS) install user: The user that will run the Web Tier install will need to be in this 
group prior to running that install in the next section. 

 Application Tier (Costpoint) Windows Service account: The user that you will use to start 
and run the Costpoint Windows Service. 

 Application Tier (Costpoint) Tools user: The user that you will use to log in to the 
application server to run any of the Costpoint tools, such as the Config Utility, Migrate User 
Utility, or DBWizard. 

3. Reboot your Costpoint 8.2 application server. 

Before You Start 
Before starting this procedure, make sure that you meet all Costpoint 8.2 Server Startup Prerequisites. 

Manually Start Costpoint 8.2 
This section provides the steps that you complete to start Costpoint 8.2. You must start the Costpoint 8.2 
WebLogic Server on your application server to gain access to the Costpoint 8.2 system. 
You must perform this procedure on your Costpoint 8.2 application server. 

To start Costpoint 8.2: 
1. Right-click Start, select Search. 

2. Enter “Costpoint 8.2”, and open file location for Start Costpoint 8.2. 

3. Right-click Start Costpoint 8.2 and click Run as Administrator on the shortcut menu. 

 
This opens a Windows Command Prompt and launches a command script that starts the 
Costpoint 8.2 WebLogic Server. When the Windows Command Prompt window opens, you will 
see a series of messages scrolling down the screen.  

Starting the Costpoint 8.2 WebLogic Server can take a long time to complete. Please do not 
interrupt the process. 

4. After the Costpoint 8.2 WebLogic Server has successfully started, the following message displays 
at the bottom of the command line shell window: 

<The server started in RUNNING mode.> 
If the Costpoint 8.2 WebLogic Server encounters errors during the startup process, the message 
will not be displayed, and the command line shell (DOS window) may terminate. 

Note: Due to enhanced security in Windows Server, it is advised that you use the Run as 
Administrator option when launching this command even if the logged in user has local 
administrative rights. 
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If the message does not display or if the command line shell (DOS window) terminates, you must 
perform the following: 

 Make a copy of the C:\Deltek\Costpoint\82\logs\DEServer.log file. 

 Contact Deltek Costpoint Technical Support. 

Install the Costpoint 8.2 Windows Service 
This section provides the steps for installing the Costpoint 8.2 Windows service. 

This procedure must be performed on your Costpoint 8.2 WebLogic application server. 

To install Costpoint 8.2 to run as a Windows service: 
1. Stop the Costpoint 8.2 WebLogic Server. 

 
2. Use Windows Explorer to navigate to the directory where the Costpoint 8.2 software was installed 

(C:\Deltek\Costpoint\82\bin), right-click InstallCPWebasService.cmd, and select Run as 
administrator. 

Configure the Costpoint 8.2 Windows Service 
This section provides the steps for configuring the Costpoint 8.2 Windows service. 

This procedure must be performed on your Costpoint 8.2 WebLogic application server. 

To configure Costpoint 8.2 Windows service: 
1. Click Start » Administrative Tools » Services. 

2. On the Services window, scroll down the Services drop-down list, right-click the Costpoint 8.2 
service, and then click Properties on the shortcut menu. 

If you cannot find the Costpoint 8.2 service, the service must not have installed properly in the 
previous step. Please repeat Step 1 of Install the Costpoint 8.2 Windows Service. 

3. On the Costpoint 8.2 Properties screen, click the Recovery tab, and complete the following. 

Field Name Action 

First failure Change the drop-down selection from Take No Action to Restart the 
Service. 

Second failure Accept the default value, Take No Action. 

Subsequent 
failures 

Accept the default value, Take No Action. 

Reset fail count 
after 

Change the value from 0 to 1 days. 

Attention: See the Stop Costpoint 8.2 WebLogic Server from the Web Browser section for 
information on starting and stopping the Costpoint 8.2 WebLogic Server. 



Application Tier Installation 

Microsoft SQL Server 44 

 

Field Name Action 

Restart service 
after 

Accept the default value, 1 minute. 

4. Click Apply. 

5. On the Costpoint 8.2 Properties screen, click the Log On tab, and complete the following. 

Field Name Action 

Account Enter the domain Account (for example, domain\useraccountname). 

If using a domain service login account instead of the "Local System 
Account," select This Account. 

Password Enter the password for the domain Account. 

Confirm Password Re-enter your password for the domain Account. 

6. Click Apply.  

Make sure that the login account for the Costpoint Service is in the local Administrators group on 
the Application Tier server and is part of the local security group created by the Application Tier 
installer, CostpointToolsGroup. 

Also, keep in mind that this login account must be given full access permissions for any Alternate 
File locations setup (network shared directories). Alternate File locations are used for Costpoint 
users for uploading and downloading files from within Costpoint. 

7. On the Costpoint 8.2 Properties screen, click the General tab, and click Start to start the 
Costpoint 8.2 service. 

The service will indicate that it started immediately. However, please note that it takes several 
minutes for the Costpoint 8.2 service to fully initialize. 

After starting the service, wait several minutes before attempting to connect to the software. 

If you encounter problems with the Costpoint 8.2 service, check the 
C:\Deltek\Costpoint\82\logs\DEServer.log file and report any errors to Deltek Costpoint Technical 
Support. 

8. Click OK to close the Costpoint 8.2 Properties screen, and close the Services window. 



Web Tier Installation 

Microsoft SQL Server 45 

 

Web Tier Installation 
The steps to integrate your Costpoint 8.2 software with the Microsoft Internet Information Server (IIS) are 
detailed in this section. 

The Microsoft Internet Information Server component is optional. The WebLogic Server software 
includes an integrated web server component that you can use with the Costpoint 8.2 software. 

Although the use of the IIS component is optional, Deltek strongly recommends that you install it in your 
production environment. In addition to acting as the proxy, the IIS server is also used to load balance the 
cluster nodes. 

Before You Start 
Make sure that you meet all Web Tier Installation/Microsoft Internet Information Server (IIS) Configuration 
Prerequisites. 

Install Microsoft IIS Web Server for Costpoint 8.2 using 
PowerShell (Admin) 
This section provides the steps that you need complete to configure Microsoft IIS prior to the installation 
of Costpoint 8.2 using PowerShell (Admin). 

 
You must perform this procedure on a web server that uses Microsoft Internet Information Server. 

To install IIS features: 
1. Open Windows PowerShell (Admin). 

2. Run this command to install features: 
Install-WindowsFeature -Name Web-Server,Web-ISAPI-Ext,Web-Mgmt-Compat,Web-
Metabase,Web-Scripting-Tools -IncludeManagementTools 

3. Run this command to verify installed features: 
get-WindowsFeature -name Web-* 

Install Microsoft IIS Web Server for Costpoint 8.2 using 
Server Manager 
This section provides the steps to manually configure Microsoft IIS prior to the installation of Costpoint 8.2 
using Server Manager. 

 
You must perform this procedure on a web server that uses Microsoft Internet Information Server. 

Note: To manually configure using Server Manager, skip this procedure and proceed to the 
next procedure. 

Note: If you installed the required features in the previous procedure using PowerShell 
(Admin), you can skip this section. 
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To configure Microsoft IIS Web server: 
1. Click Start » Programs and Features. 

2. Click the Turn Windows features on or off link. 

3. On the Server Manager screen, select Add Roles and Features. 

4. On the Before you begin screen, click Next >. 

5. On the Select installation type screen, accept the default of Role-based or feature-based 
installation, and click Next >. 

6. On the Select destination server, accept the default of Select a server from the server pool, 
which should have automatically selected the IIS server you are on, and click Next >. 

7. On the Select server roles screen, scroll down and select Web Server (IIS). 
8. On the Add features that are required for Web Server (IIS) screen, click Add Features. 

9. On the Select server roles screen, click Next >. 

10. On the Select features screen, click Next >. 

11. On the Web Server Role (IIS) screen, click Next >. 

12. On the Select role services screen, perform the following: 

a. Scroll down, expand Application Development, and select ISAPI Extensions. 

b. Scroll down, under Management Tools, expand IIS 6 Management Compatibility, and 
select IIS 6 Metabase Compatibility. 

c. Scroll down and select IIS Management Scripts and Tools. 

d. Click Next >. 

13. On the Confirm installation selections screen, click Install. 
14. After the installation is complete, click Close. 

15. From the upper right of Server Manager, click Tools, and select Internet Information Services 
(IIS) Manager. 

16. On the Internet Information Services (IIS) Manager screen, right-click your IIS computer name 
icon, and click Stop. 

17. Right-click your IIS computer name icon again, and click Start. 
18. Close the Internet Information Services (IIS) Manager window. 

19. Close the Services Manager window. 

20. Close the Control Panel window. 

Install Web Tier Software 
The steps to integrate the Costpoint 8.2 system with Microsoft IIS are detailed in this section. 

You must perform this step on a web server that is using Microsoft Internet Information Server. 

You must have Internet access on the machine where the Costpoint 8.2 installer is invoked in order to 
download the latest DeltekCostpoint82RequirementsINI.exe file automatically. The file contains the latest 
OS platforms and database versions supported. If your web server has Internet access, the file is 
automatically downloaded when you launch the Web Tier installation. 
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If your application server does not have Internet access, you need to perform the steps in the Latest 
Installer Files Download Instructions section of this document before you run the 
DeltekCostpoint82WebTier.exe file. 

To install Costpoint 8.2 on your Microsoft IIS Web server: 
1. Run the DeltekCostpoint82WebTier_Buildxx.exe file to launch the Costpoint 8.2 Web Tier 

installation program.  

 
2. On the Welcome to the InstallShield Wizard for Deltek Costpoint Web screen, click Next >.  

3. On the Choose Destination Location screen, click Browse to navigate to an installation location 
for the Deltek Costpoint 8.2 IIS software.  

The default is C:\Deltek\Costpoint\82\applications (recommended). 

The installation process populates the folder selected above with a \DEWebApp folder that 
contains all the program files you need to integrate the Costpoint 8.2 software that resides on 
your application server with your Microsoft IIS Web server. 

4. Click Next >. 

5. On the Costpoint WebLogic System Information screen, complete the following fields. 

Field Name Action 

IP Address or 
Hostname 

Enter the IP address (10.2.2.154) or hostname (appsvr01) of your 
Costpoint 8.2 WebLogic application server. 

The IP Address or Hostname must not be 127.0.1.0.1 or localhost. 

Listen Port Enter the Listener Port for your Costpoint 8.2 WebLogic application 
server. You specified this port during the Costpoint 8.2 application 
server software installation. The default port is 7009 (recommended). 

Your Microsoft IIS Web server will use the IP address or hostname 
and Listener Port information to forward requests to your Costpoint 
8.2 WebLogic application server. This port must match the one 
entered during the Costpoint 8.2 Application Server installation. 

6. Click Next >.  

7. On the Deltek Costpoint Web Tier IIS Website screen, locate the Website Name field and select 
the website where you want to create the Deltek Costpoint 8.2 Virtual Directory (CPWeb).  

Typically, this is the Default Web Site.  

8. Click Next >. 

Note: The Deltek product installers contain functionality which enables them to dynamically download 
configuration files and patch rollback scripts when the product installers are executed from the Deltek 
Software Manager server. To improve security, these connections have been modified to require 
communication over HTTPS. 

Note: Due to enhanced security in Windows Server, it is advised that you use the Run as 
Administrator option when launching the executable files even if the logged in user has 
local administrative rights. 



Web Tier Installation 

Microsoft SQL Server 48 

 

9. On the Pre-Installation Summary screen, review the installation parameters you have selected: 

 If you want to change any settings, click < Back to go back and make the necessary 
changes.  

 If you are satisfied with these settings, click Install > to begin the installation. 

Once initiated, the installation process can take a long time to complete. Please do not interrupt 
the process.  

The installation performs the scenarios detailed in the Installation “Process for Costpoint 8.2, Web 
Tier Installation” section of this document.  

The installation process creates the CPWeb Virtual Directory under the Default Website, using 
the Default App Pool. The process also creates a share of your Costpoint 8.2 Costpoint directory, 
C:\Deltek\Costpoint\82\applications. In order for the Application Server (WebLogic) to deploy hot 
fixes and updates, this directory must be shared with Co-Owner (Full Control) rights. 

During the installation process, a new User Group, CostpointToolsGroup, is created and given 
Full Sharing and Security rights on C:\Deltek\Costpoint\82\applications. 

10. Upon completion, the Deltek Costpoint Web – Installation Summary Results screen displays the 
results of the installation process.  

For each step executed, you should see a SUCCESS message. 

Any FAILED messages or Errors indicated should be further researched in the applicable detailed 
log file(s) and reported to Deltek Costpoint Technical Support. 

11. Click Next >. 

12. On the InstallShield Wizard Complete screen, complete the following fields. 

Field Name Action 

Launch the 
installer summary 
file 

Select this checkbox to review the summary log file. This displays the 
same data from the previous screen.  

Launch the 
installer log file 

Select this checkbox to review the Deltek Costpoint Application installer 
log file. 

13. Click Finish to exit the installation. 

Please review all log files for any Errors or reported issues. Although to help identify any 
issues, all Errors will be in the AppTier_Install_ErrorSummaryResults.log, from the 
C:\Program Files\Deltek\Costpoint\8.2\Logs\WebTier_Installer folder. 
The following errors can be ignored when installing WebTier on the same box as your AppTier. 

ADSCreateLocalGroup Error: System.Runtime.InteropServices.COMException 
(0x82070563): The specified local group already exists. 

ADSCreateLocalGroup Error: The account already exists. Returning True 

Please refer to the Post Installation Web Tier Installer Log Files section for more information on 
the logs folder structure and contents. 

Make sure that Network Discovery and File Sharing options are switched on. 

 
Note: If you are running an IIS web cluster, you must repeat this step for all of your IIS web servers. 
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Add Users to the CostpointToolsGroup 
The steps to add the necessary users to the newly created CostpointToolsGroup are detailed in this 
section. The Web Tier installation added this group to your Web server and has granted the group Full 
Sharing and Full Security Permissions to the folder containing your DEWebApp folder, 
C:\Deltek\Costpoint\82\applications. 

You must perform this step on your Costpoint 8.2 Web server. 

To add users to the newly created CostpointToolsGroup: 
1. Open Computer Management. 
2. From Computer Management, Local Users and Groups, Groups, add the following user to the 

CostpointToolsGroup group: 

 Application Tier (Costpoint) Tools user: The user that you will use to log in to the 
application server to run any of the Costpoint tools, such as the Config Utility, Migrate User 
Utility, or DBWizard. 

3. Reboot your Costpoint 8.2 Web server. 

Configure Costpoint 8.2 IIS Access 
The steps to configure Costpoint 8.2 to work through IIS are detailed in this section. 

You must perform this step on your Costpoint 8.2 WebLogic application server. 

To configure Costpoint 8.2 and IIS: 
1. With your Costpoint 8.2 service running, right-click Start, and select Search. 

2. Enter “Costpoint 8.2,” right-click Start Costpoint 8.2 Config Utility, and click Run as 
Administrator. 

 
3. On the Select Your Configuration Options screen, make sure the IIS Connection Configuration 

checkbox is selected, and click Next. 
4. On the Costpoint Configuration Utility screen, click the IIS tab and perform the following for each 

of your IIS Web Servers: 

Field Name Action 

Use IIS #1 Select this checkbox. This option is cleared by default. 

Configuration File 
Location 
(iispoxy.ini) 

Click the ellipsis button and navigate to the \\CPiisServer\Costpoint 
folder share on your IIS server. 

Select the DEProxy\lib folder to access the iisproxy.ini file and click 
Open. 

Click OK after the following message displays: "Configuration file 
iisproxy.ini was successfully loaded." 

Note: Due to the enhanced security in Windows Server, it is advised to that you use the Run 
as Administrator option when launching this command even if the logged in user has local 
administrative rights. 
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Field Name Action 

DEWebApp Folder 
Location 

Click the ellipsis button and navigate to the shared 
\\CPiisServer\Costpoint folder on your IIS server. 

Navigate to the folder containing your DEWebApp folder (that is, 
\\CPiisServer\Costpoint\82\applications), and click Open. 

WebLogic Host IP Enter your WebLogic application server name. 

Port Enter the WebLogic Listener Port, 7009. 

5. Click Save.  

The following message displays: 

 
6. Click OK, and then click Close. 

Restart Costpoint 8.2 WebLogic Server 
The steps to stop and restart your Costpoint 8.2 WebLogic Server are detailed in this section. 

You must perform this step on your Costpoint 8.2 WebLogic application server. 

To stop and restart your Costpoint 8.2 WebLogic Server: 
1. Click Start » Administrative Tools » Services. 

2. On the Services window opens, scroll down the Services list, and Stop the Costpoint 8.2 
service. 

3. After the service stops, Start the Costpoint 8.2 service. 

 
4. Close the Services window. 

Note: The service immediately indicates that it has started. However, please note that it takes 
several minutes for the Costpoint 8.2 service to fully initialize. 

After starting the service, wait several minutes before attempting to connect to the software. 

If you encounter problems with the Costpoint 8.2 service, check the 
C:\Deltek\Costpoint\8.2\logs\DEServer.log file and report any errors to Deltek Costpoint 
Technical Support. 
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Costpoint 8.2 Initial Log In Configuration 
The steps to configure your browser and verify your Costpoint 8.2 Application Tier and Web Tier 
installations are detailed in this section. To confirm that these servers are functioning properly, you will log 
in to Costpoint 8.2 and preview a report. 

Before You Start 
Make sure that you meet all Costpoint 8.2 Initial Log In Configuration Prerequisites. 

Configure Costpoint 8.2 Printer 
This step is optional. It provides configuration instructions for your Application Tier WebLogic Server to 
allow you to print Costpoint 8.2 reports. This is useful for asynchronous printing from the server, 
especially for tasks such as printing reports through the Job Server in the middle of the night. 

 
You must perform this step on your Costpoint 8.2 application server. 

To create Windows printer objects on your application server: 
1. Right-click Start, click Control Panel. 
2. Under Hardware, select View devices and printers. 

3. On the Printers and Faxes screen, double-click Add Printer. 
4. Use the Add Printer Wizard to create a Windows printer object that will connect and print to a 

printer on your network. 

On your application server, you can create as many Windows printer objects as needed for your 
organization. After the printer objects are created, your Costpoint 8.2 WebLogic application server will 
make the printer objects available to your users. 

Log In to Costpoint 8.2 
The steps to log in to Costpoint 8.2 are detailed in this section. 

You can perform this step from any Windows client workstation that has TCP/IP access to your Costpoint 
8.2 WebLogic application server. 

 

To log in to Costpoint 8.2: 
1. Open your web browser, and enter one of the following URLs: 

 http://<AppServerIPAddress or ComputerName>:<Port> 

Note: Users can print to local printers from the workstations without configuring anything in this step. 

Note: Depending on your environment, you may need to add your Costpoint 8.2 URL under Local 
Internet instead of Trusted sites. 

Disable any pop-up blockers or explicitly allow pop-ups for the Costpoint 8.2 URL, such as 
http://<IPAddress or ComputerName>, where <IPAddress or ComputerName> identifies your 
Costpoint 8.2 WebLogic application server or IIS Web server (for example, http://10.2.2.154). 

http://10.2.2.154/
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 http://<WebServerIPAddress or ComputerName>/cpweb 

Where <AppServerIPAddress or ComputerName> identifies your Costpoint 8.2 WebLogic 
application server and <Port> identifies the unique port number that your Costpoint 8.2 WebLogic 
application server uses to listen for connections. You specified this port value during the 
Costpoint 8.2 software installation. The default is 7009 (for example, http://10.2.2.154:7009). 

Or where <WebServerIPAddress or ComputerName> identifies your Costpoint 8.2 IIS Web server 
(for example, http://10.2.2.156/cpweb). 

2. When the Deltek Costpoint screen displays, complete the following. 

Field Name Action 

Username Enter CPSUPERUSER. 

Password Enter password. The password is case-sensitive and must be entered 
in lowercase. Passwords that you create for other user IDs may be 
uppercase, lowercase, or mixed. 

System Enter <Your_System_Name>, where <Your_System_Name> 
identifies the system name you assigned to your Costpoint 8.2 system 
during the Application Server Installation. Typically, customers use a 
system name that is identical to their Costpoint 8.2 Database name, 
DELTEKCP. 

ADDITIONAL 
CRITERIA 

Click + to display these additional fields: 

 Application: Accept the blank default value or enter a specific 
Costpoint 8.2 application (for example, COSTPOINT MENU). 

 Company: Enter your company ID (for example, 1). 

 Validation Frequency: Accept the default drop-down value, Field. 
After you have successfully logged in to Costpoint 8.2, review the 
online help for a detailed explanation of the value you can select 
for this field. 

 Language: Accept the default drop-down value, English, or 
change to your language. 

Remember me Select this checkbox to have the system remember your login 
information. This checkbox is not selected by default. 

3. Click Log In. 

4. When the Your password has expired screen displays, complete the following. 

Field Name Action 

Current Password Enter password. The password is case-sensitive and must be entered 
in lowercase. 

New Password Enter a new password for the CPSUPERUSER account. Passwords 
are case-sensitive and may be uppercase, lowercase, or mixed. 

Confirm Password Re-enter your new password for CPSUPERUSER. 



Costpoint 8.2 Initial Log In Configuration 

Microsoft SQL Server 53 

 

5. Click Log In. 

6. From the main menu screen, click Admin » System Administration » Printing » Manage 
System Printers. 

7. On the Manage System Printers screen, click New Record (+).  

8. Complete the following fields. 

Field Name Action 

Printer ID Click the magnifying glass icon to display all printer objects that are 
available on your Application Server. Select the appropriate printer 
object by clicking the checkbox to the left of the printer object name and 
then clicking SELECT. 

Printer Name Enter a descriptive name for the printer object. 

9. Select the Assigned Users/User Groups link located in the lower-right corner of the System 
Printers section. 

10. When the focus switches to the Assigned Users/User Groups section at the bottom half of your 
browser window, click New Record (+), and complete the following fields. 

Field Name Action 

User/User Group 
ID or User/User 
Group Name 

Click the magnifying glass for one of these fields. Select a User/User 
Group that should have access to the printer object you specified above. 

Company Click the magnifying glass. Select a Company for this User/User Group. 

11. Click SELECT.  

You must repeat Step 9 for each User/User Group that you want to assign the printer object that 
you specified earlier. 

12. Click Save, and then click OK when the following message displays: “Record modifications 
completed without error.” 

You must repeat items 6–11 for any printer objects on your Application server that you want to 
make available to your Costpoint 8.2 system users. 

13. Click File » Log-out to exit Costpoint 8.2.  

14. Close your web browser. 

Verify Costpoint 8.2 Printer Configuration 
The steps to verify your Costpoint 8.2 printers are detailed in this section. 

This step can be performed from any Windows client workstation that has TCP/IP access to your 
Costpoint 8.2 WebLogic application server. 

To verify your Costpoint 8.2 printers: 
1. Open your Web browser, and enter one of the following URLs: 

 http://<AppServerIPAddress or ComputerName>:<Port> 
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 http://<WebServerIPAddress or ComputerName>/cpweb 

Where <AppServerIPAddress or ComputerName> identifies your Costpoint 8.2 WebLogic 
application server and <Port> identifies the unique port number that your Costpoint 8.2 WebLogic 
application server uses to listen for connections. You specified this port value during the 
Costpoint 8.2 software installation. The default is 7009 (for example, http://10.2.2.154:7009). 

Or where <WebServerIPAddress or ComputerName> identifies your Costpoint 8.2 IIS Web server 
(for example, http://10.2.2.156/cpweb). 

2. On the Deltek Costpoint screen, complete the following fields. 

Field Name Action 

Username Enter CPSUPERUSER. 

Password Enter the CPSUPERUSER user password. The default was 
password. 

System Enter <Your_System_Name>, where <Your_System_Name> 
identifies the system name you assigned to your Costpoint 8.2 system 
during the Application Server Installation process. Typically, customers 
use a system name that is identical to their Costpoint 8.2 Database 
name, DELTEKCP. 

SHOW ADDITIONAL 
CRITERIA 

Click + to display these additional fields: 

 Application: Accept the blank default value or enter a specific 
Costpoint 8.2 application (for example, COSTPOINT MENU). 

 Company: Enter your company ID (for example, 1). 

 Validation Frequency: Accept the default drop-down value, 
Field. After you have successfully logged in to Costpoint 8.2, 
review the online help for a detailed explanation of the value you 
can select for this field. 

Remember log in 
information 

Select this checkbox to have the system remember your login 
information. This option is not selected by default. 

3. Click Log In.  

4. From the main menu screen, click Admin » Security » Security Reports/Inquiries » Print User 
Group Rights Report. 

5. On the Print User Group Rights Report screen, click Print Options. 

6. On the Print Options screen, select the System Printer or the Local Printer Delivery Option, 
depending on how you set up your Application Server printer, and click OK. 

7. On the Print User Group Rights Report screen, click Print Default Report. 
If the User Group Rights Report prints correctly, your Costpoint 8.2 Application Server printer 
setup is working properly. If the report does not print correctly, please contact Deltek Costpoint 
Technical Support. 

8. Click File » Close Application to close the Print User Group Rights Report screen. 

9. Click OK when the following message displays:  
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“You have unsaved changes. Select Cancel to go back and save changes or select OK to discard 
changes and close the application”  

10. You can now begin to configure and use the Costpoint 8.2 system.  

 
Deltek strongly recommends that you change the CPSUPERUSER user’s password.  

 

Deploy Costpoint as a Progressive Web App  
A Progressive Web App (PWA) is a web application which uses a set of latest technologies to incorporate 
the features which were historically associated with either browser or native applications. As a result, the 
PWA provides the end user with the best of both worlds.  

The Costpoint PWA application provides the same rich set of capabilities regardless of the device. For 
example, if your company configured SAML or FIDO authentication for desktops, it will work on mobile 
devices, with no extra steps or additional deployment/configuration necessary. If you developed an 
Extension, it will work on a desktop, tablet, or phone. If your users access Costpoint from your company 
Azure portal using SSO, it will equally work on a laptop or phone.  

As Costpoint is being constantly enhanced, you can be confident that your company and your users will 
always have access to the latest features and functionality while using Costpoint PWA, regardless of the 
device used to access Costpoint. 

From an IT perspective, the use of Costpoint PWAs on mobile devices have these additional benefits: 

 The instructions to install Costpoint PWA on your device (similar to installing a native app from a 
store) describe a manual process. However, because it is not required to publish PWA 
applications to the store, IT can push Costpoint PWA application to your employee devices using 
standard MDM solutions (for example, MobileIron). 

 If your company has an internal company store which employees should use to download 
applications (for example, using MobileIron store), a PWA application can be published in your 
company store.  

 IT has full control over the version of Costpoint used by users, including the PWA application 
deployed to user devices. When your company IT or Deltek Cloud deploys any new update to 
Costpoint, the PWA applications on user devices will refresh automatically and seamlessly, 
always staying in sync with the version of Costpoint used by your organization. 

 There is no need to worry about backward or forward compatibility issues with the version of 
applications deployed on user devices, and no need to ask or expect users to download an 
updated version of the application from the company store. 

 

Attention: Please refer to the Related Documentation section for a list of all documentation 
included with the Costpoint 8.2 release. 

Attention: Please refer to the Change CPSUPERUSER User’s Password section for 
instructions.  

Note: Deploying a PWA application using the procedures outlined below does not only create an icon 
on your home screen but also generates a real native application container on your device. For 
example, you can tap the standard App info option for the Costpoint icon on an Android device and it 
will show that the CP icon you just created is a native application, downloaded from Google Play 
store. 
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Deploy Costpoint PWA on an Android Device 
You can install the Costpoint PWA from the Costpoint Login page or the Chrome browser menu. 

To deploy Costpoint PWA via the Costpoint Login page: 
1. On your Android device, open the Costpoint Login page in the Chrome browser. 

2. Tap Add to Home screen. 

3. Name the Costpoint PWA, and then click Add. 

You can now tap the icon on your Home screen to launch Costpoint as a stand-alone web app. 

To deploy Costpoint PWA via the Chrome browser menu: 
1. On your Android device, open the Costpoint Login page in the Chrome browser. 

2. Tap the menu (three vertical dots) in the upper-right corner. 

3. Tap Add to Home screen. 

4. Tap Add. 

You can now tap the icon on your Home screen to launch Costpoint as a stand-alone web app. 

Deploy Costpoint PWA on an iPhone or iPad 

To deploy Costpoint PWA: 
1. On your iPhone or iPad, open the Costpoint Login page in the Safari browser. 

2. Tap the Share icon. 

3. Tap the Add to Home Screen icon. 

4. Name the Costpoint PWA. 

5. Tap Add in the upper-right corner. 

You can now tap the icon on your Home screen to launch Costpoint as a stand-alone web app. 

Deploy Costpoint PWA on a Desktop  
Deploying the Costpoint PWA on your desktop creates a desktop shortcut to the application. When you 
access Costpoint using the app, more data is visible on your screen. Browser elements, like the address 
bar, tabs, and other controls, are removed, offering a clearer view of your Costpoint data.  

 

To deploy Costpoint PWA in Google Chrome: 
1. Open the Costpoint Login page. 

2. Install Costpoint PWA using one of the following three options: 

 In the Address bar, click + (Install Costpoint) » Install. 
 In the browser menu (three vertical dots), click Install Costpoint » Install. 
 On the Costpoint Login page, click Add to Home Screen » Install. 

Note: Support for Microsoft Edge is coming soon. 
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Maintenance Release Installation 

Apply Latest Costpoint 8.2 Maintenance Release (MR) 
After you have a functioning Costpoint 8.2 environment, follow the 
DeltekCostpoint82MaintenanceReleaseInstallation.pdf installation document to install the latest 
Costpoint 8.2 MR. 
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Post-Installation Configuration 

Database Tier Installer Log Files 
Database Tier Installation logs are written to the following folder: 

C:\Program Files\Deltek\Costpoint\8.2\Logs\DBTier_Installer 
Each of these log files are detailed in the table below, but here is a look at the log folder/file structure: 

C:\Program Files\Deltek\Costpoint\8.2\Logs\DBTier_Installer 

DBTier_Install.log 

DBTier_Install_ErrorSummaryResults.log 

DBTier_Install_SummaryResults.log 

DatabaseSteps.txt 

C:\Program Files\Deltek\Costpoint\8.2\Logs\DBTier_Installer\CP_ADMIN 

addDeltekLoginToAdminDB.bat.log 

createDeltekUserInAdminDB.bat.log 

DeltekCreateLinkUser.bat_ADMIN.log 

DeltekCreateLinkUserLogin.bat_ADMIN.log 

MSSQLNewAdminDatabaseSetup82.bat.log 

C:\Program Files\Deltek\Costpoint\8.2\Logs\DBTier_Installer\CP_SYSTEM 

addAdminLoginToSystemDB.bat.log 

addDeltekLoginToSystemDB.bat.log 

createAdminUserInSystemDB.bat.log 

createDeltekUserInSystemDB.bat.log 

DeltekCreateLinkUser.bat_SYSTEM.log 

DeltekCreateLinkUserLogin.bat_SYSTEM.log 

MSSQLNewSystemDatabaseSetup82.bat.log 

C:\Program Files\Deltek\Costpoint\8.2\Logs\DBTier_Installer\CP_TRANS 

DeltekCreateLinkUser.bat_CP_TRANS.log 

DeltekCreateLinkUserLogin.bat_CP_TRANS.log 

MSSQLNewTransactionDatabaseSetup82.bat.log 

C:\Program Files\Deltek\Costpoint\8.2\Logs\DBTier_Installer\PL_TRANS 

DeltekCreateLinkUser.bat.log 

DeltekCreateLinkUserLogin.bat.log 

DeltekCreatePLUserInCPTran.bat.log 

DeltekCreatePLUserInTETran.bat.log 

MSSQLNewPLDatabaseSetup82.bat.log 

C:\Program Files\Deltek\Costpoint\8.2\Logs\DBTier_Installer\TE_TRANS 

DeltekCreateLinkUser.bat_TE_TRANS.log 
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DeltekCreateLinkUserLogin.bat_TE_TRANS.log 

DeltekCreateTEUserInCPTran.bat_TE_TRANS.log 

MSSQLNewTEDatabaseSetup82.bat.log 

C:\Program Files\Deltek\Costpoint\8.2\Logs\DBTier_Installer\XA_TRANS 

instjdbc_CPTRAN.log 

instjdbc_PL.log 

instjdbc_TE.log 

MSDTC.log 

C:\Program Files\Deltek\Costpoint\8.2\Logs\DBTier_Installer\InstallerLogArchive 

Log Name Description What to Look 
For 

C:\Program Files\Deltek\Costpoint\8.2\Logs\DBTier_Installer 

DBTier_Install.log Main DB Tier installation Log 
File. Shows detailed results of 
all processes executed in the 
installer. 

(Multiple log files for this, older 
ones from previous DB Tier 
installer runs stored under 
InstallerLogArchive folder.) 

Date and Build 
number at the top, 
Installation Success or 
failed at the bottom. 
Installation details, 
Error or Failed 
messages in between. 

DBTier_Install_SummaryResults.log Installer Summary description 
Panel output written to a log 
file. Contains the results of the 
installation process.  

(Multiple log files for this, older 
ones from previous DB installer 
runs stored under 
InstallerLogArchive folder.) 

SUCCESS items, 
FAILED items with 
error messages, 
and/or Warning 
messages. 

DBTier_Install_ErrorSummaryResults.log DB Tier installer error output 
written to a log file. Contains 
any ERROR results of the 
installation process.  

(Multiple log files for this, older 
ones from previous DB installer 
runs stored under 
InstallerLogArchive folder.) 

Any errors during the 
installation will be 
written to this file. This 
will then lead you to 
the other logs for more 
detailed description of 
the errors. 

DatabaseSteps.txt   

C:\Program Files\Deltek\Costpoint\8.2\Logs\DBTier_Installer\CP_ADMIN 

addDeltekLoginToAdminDB.bat.log Results of adding CPTRAN 
user login to DELTEKADM 
database. 

Will show any issues, 
that it completed 
successfully, or that 
the login already 
exists. 
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Log Name Description What to Look 
For 

createDeltekUserInAdminDB.bat.log Results of creating CPTRAN 
user in DELTEKADM database. 

Will show any issues, 
that it completed 
successfully, or that 
the login already 
exists. 

DeltekCreateLinkUser.bat_ADMIN.log Results of creating 
CPLINK_USER in 
DELTEKADM database. 

Will show any issues, 
that it completed 
successfully, or that 
the login already 
exists. 

DeltekCreateLinkUserLogin.bat_ADMIN.log Results of adding 
CPLINK_USER user login to 
DELTEKADM database. 

Will show any issues, 
that it completed 
successfully, or that 
the login already 
exists. 

MSSQLNewAdminDatabaseSetup82.bat.log Detailed results for setting up 
the DELTEKADM database. 

Will show any issues 
or 
$DBSUCCESS=TRUE 
at the end of the log 
file. 

C:\Program Files\Deltek\Costpoint\8.2\Logs\DBTier_Installer\CP_SYSTEM 

addAdminLoginToSystemDB.bat.log Results of adding CPADMIN 
user login to DELTEKSYS 
database. 

Will show any issues, 
that it completed 
successfully, or that 
the login already 
exists. 

addDeltekLoginToSystemDB.bat.log Results of adding CPTRAN 
user login to DELTEKSYS 
database. 

Will show any issues, 
that it completed 
successfully, or that 
the login already 
exists. 

createAdminUserInSystemDB.bat.log Results of creating CPADMIN 
user in DELTEKSYS database. 

Will show any issues, 
that it completed 
successfully, or that 
the login already 
exists. 

createDeltekUserInSystemDB.bat.log Results of creating CPTRAN 
user in DELTEKSYS database. 

Will show any issues, 
that it completed 
successfully, or that 
the login already 
exists. 

DeltekCreateLinkUser.bat_SYSTEM.log Results of creating 
CPLINK_USER in 
DELTEKSYS database. 

Will show any issues, 
that it completed 
successfully, or that 
the login already 
exists. 
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Log Name Description What to Look 
For 

DeltekCreateLinkUserLogin.bat_SYSTEM.log Results of adding 
CPLINK_USER user login to 
DELTEKSYS database. 

Will show any issues, 
that it completed 
successfully, or that 
the login already 
exists. 

MSSQLNewSystemDatabaseSetup82.bat.log Detailed results for setting up 
the DELTEKSYS database. 

Will show any issues 
or 
$DBSUCCESS=TRUE 
at the end of the log 
file. 

C:\Program Files\Deltek\Costpoint\8.2\Logs\DBTier_Installer\CP_TRANS 

DeltekCreateLinkUser.bat_CP_TRANS.log Results of creating 
CPLINK_USER in DELTEKCP 
database. 

Will show any issues, 
that it completed 
successfully, or that 
the login already 
exists. 

DeltekCreateLinkUserLogin.bat_CP_TRANS.log Results of adding 
CPLINK_USER user login to 
DELTEKCP database. 

Will show any issues, 
that it completed 
successfully, or that 
the login already 
exists. 

MSSQLNewTransactionDatabaseSetup82.bat.log Detailed results for setting up 
the DELTEKCP database. 

Will show any issues 
or 
$DBSUCCESS=TRUE 
at the end of the log 
file. 

C:\Program Files\Deltek\Costpoint\8.2\Logs\DBTier_Installer\PL_TRANS 

DeltekCreateLinkUser.bat.log Results of creating 
CPLINK_USER in DELTEKPL 
database. 

Will show any issues, 
that it completed 
successfully, or that 
the login already 
exists. 

DeltekCreateLinkUserLogin.bat.log Results of adding 
CPLINK_USER user login to 
DELTEKPL database. 

Will show any issues, 
that it completed 
successfully, or that 
the login already 
exists. 

DeltekCreatePLUserInCPTran.bat.log Results of creating PLTRAN 
user in DELTEKCP database. 

Will show any issues, 
that it completed 
successfully, or that 
the login already 
exists. 

DeltekCreatePLUserInTETran.bat.log Results of creating PLTRAN 
user in DELTEKTE database. 

Will show any issues, 
that it completed 
successfully, or that 
the login already 
exists. 
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Log Name Description What to Look 
For 

MSSQLNewPLDatabaseSetup82.bat.log Detailed results for setting up 
the DELTEKPL database. 

Will show any issues 
or 
$DBSUCCESS=TRUE 
at the end of the log 
file. 

C:\Program Files\Deltek\Costpoint\8.2\Logs\DBTier_Installer\TE_TRANS 

DeltekCreateLinkUser.bat_TE_TRANS.log Results of creating 
CPLINK_USER in DELTEKTE 
database. 

Will show any issues, 
that it completed 
successfully, or that 
the login already 
exists. 

DeltekCreateLinkUserLogin.bat_TE_TRANS.log Results of adding 
CPLINK_USER user login to 
DELTEKTE database. 

Will show any issues, 
that it completed 
successfully, or that 
the login already 
exists. 

DeltekCreateTEUserInCPTran.bat_TE_TRANS.log Results of creating TETRAN 
user in DELTEKCP database. 

Will show any issues, 
that it completed 
successfully, or that 
the login already 
exists. 

MSSQLNewTEDatabaseSetup82.bat.log Detailed results for setting up 
the DELTEKTE database. 

Will show any issues 
or 
$DBSUCCESS=TRUE 
at the end of the log 
file. 

C:\Program Files\Deltek\Costpoint\8.2\Logs\DBTier_Installer\XA_TRANS 

Instjdbc_CPTRAN.log Results of enabling JDBC XA 
procedures for CP Transaction 
database. 

Will show any issues 
or that it completed 
successfully. 

Instjdbc_PL.log Results of enabling JDBC XA 
procedures for PL Transaction 
database. 

Will show any issues 
or that it completed 
successfully. 

Instjdbc_TE.log Results of enabling JDBC XA 
procedures for TE Transaction 
database. 

Will show any issues 
or that it completed 
successfully. 

MSDTC.log Results of restating the 
Distributed Transaction 
Coordinator. 

Will show any issues 
or that it completed 
successfully. 

C:\Program Files\Deltek\Costpoint\8.2\Logs\DBTier_Installer\InstallerLogArchive 

 Copies of current log files will 
get moved to these folders if 
more than one run of the DB 
Tier installer is done. 
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Application Tier Installer Log Files 
Applicaiton Tier Installation logs are written to the following folder: 

C:\Program Files\Deltek\Costpoint\8.2\Logs\AppTier_Installer 
Each of these log files are detailed in the table below, but here is a look at the log folder/file structure: 

C:\Program Files\Deltek\Costpoint\8.2\Logs\AppTier_Installer 

AppTier_Install.log 

AppTier_Install_ErrorSummaryResults.log 

AppTier_Install_SummaryResults.log 

AppTierSteps.txt 

C:\Program Files\Deltek\Costpoint\8.2\Logs\AppTier_Installer\APIs 

applyLicense_<name of license zip file>.log 

applyLicense_<name of license zip file>result.log 

linkViews.log 

linkViewsResultCode.log 

OrgSecByApplMod.log 

OrgSecByApplModResult.log 

syncSysSettingsTable.log 

syncSysSettingsTableResultCode.log 

C:\Program Files\Deltek\Costpoint\8.2\Logs\AppTier_Installer\InstallerLogArchive 

The following table provides the list of log files generated during the App Tier Installation, the folder they 
are under, along with a description of each, as well as what to look for when reviewing them. 

Log Name Description What to Look 
For 

C:\Program Files\Deltek\Costpoint\8.2\Logs\AppTier_Installer 

AppTier_Install.log Main App Tier installation Log 
File. Shows detailed results of all 
processes executed in the 
installer. 

(Multiple log files for this, older 
ones from previous App Tier 
installer runs stored under 
InstallerLogArchive folder.) 

Date and Build 
number at the top, 
Installation 
Success or failed 
at the bottom. 
Installation details, 
Error or Failed 
messages in 
between. 

AppTier_Install_SummaryResults.log Installer Summary description 
Panel output written to a log file. 
Contains the results of the 
installation process.  

(Multiple log files for this, older 
ones from previous App installer 
runs stored under 
InstallerLogArchive folder.) 

SUCCESS items, 
FAILED items with 
error messages, 
and/or Warning 
messages. 
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Log Name Description What to Look 
For 

AppTier_Install_ErrorSummaryResults.log App Tier installer error output 
written to a log file. Contains any 
ERROR results of the installation 
process.  

(Multiple log files for this, older 
ones from previous App installer 
runs stored under 
InstallerLogArchive folder.) 

Any errors during 
the installation will 
be written to this 
file. This will then 
lead you to the 
other logs for 
more detailed 
description of the 
errors. 

C:\Program Files\Deltek\Costpoint\8.2\Logs\AppTier_Installer\APIs 

applyLicense_<name of license zip file>.log Results of applying your license 
file. 

Details of applying 
License file.  If no 
issues will see this 
at the bottom: 

>License file 
applied 
successfully... 

-->Rebuilding 
Licensed 
Applications... 

-->Rebuilding 
User Menus... 

-->Done. 

-->Removing 
temporary folder... 

-->End of the 
process. 

applyLicense_<name of license zip file>result.log Results of applying your license 
file. 

Will show 1 if 
successful or 0 if 
there were issues. 

linkViews.log Log file containing details of Link 
Views process. 

Will show error 
details if any at 
bottom. 

linkViewsResultCode.log Results of applying link views. Will show 1 if 
successful or 0 if 
there were issues. 

OrgSecByApplMod.log Log file containing details of 
populating the Org Security 
Tables. 

Will show error 
details if any at 
bottom. 

OrgSecByApplModResult.log Results of populating the Org 
Security Tables. 

Will show 1 if 
successful or 0 if 
there were issues. 

syncSysSettingsTable.log Log file containing details of 
syncing the System Settings 
Tables. 

Will show error 
details if any at 
bottom. 
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Log Name Description What to Look 
For 

syncSysSettingsTableResultCode.log Results of syncing System 
Settings Tables. 

Will show 1 if 
successful or 0 if 
there were issues. 

C:\Program Files\Deltek\Costpoint\8.2\Logs\AppTier_Installer\InstallerLogArchive 

 Copies of current log files will get 
moved to these folders if more 
than one run of the App Tier 
installer is done. 

 

Web Tier Installer Log Files 
Web Tier Installation logs are written to the following folder: 

C:\Program Files\Deltek\Costpoint\8.2\Logs\WebTier_Installer 
Each of these log files are detailed in the table below, but here is a look at the log folder/file structure: 

C:\Program Files\Deltek\Costpoint\8.2\Logs\WebTier_Installer 

DeltekCostpointWebTierSetup.log 

WebTier_Setup_ErrorSummaryResults.log 

WebTier_Setup_SummaryResults.log 

C:\Program Files\Deltek\Costpoint\8.2\Logs\WebTier_Installer\InstallerLogArchive 

The following table provides the list of log files generated during the Web Tier Installation, the folder they 
are under, along with a description of each, as well as what to look for when reviewing them. 

Log Name Description What to Look 
For 

C:\Program Files\Deltek\Costpoint\8.2\Logs\WebTier_Installer 

DeltekCostpointWebTierSetup.log Main Web Tier installation Log 
File. Shows detailed results of all 
processes executed in the 
installer. 

(Multiple log files for this, older 
ones from previous Web installer 
runs stored under 
InstallerLogArchive folder.) 

Date and Build 
number at the top, 
Installation 
Success or failed 
at the bottom. 
Installation details, 
Error or Failed 
messages in 
between. 

WebTier_Setup_SummaryResults.log Installer Summary description 
Panel output written to a log file. 
Contains the results of the 
installation process.  

(Multiple log files for this, older 
ones from previous Web installer 
runs stored under 
InstallerLogArchive folder.) 

SUCCESS items, 
FAILED items with 
error messages, 
and/or Warning 
messages. 
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Log Name Description What to Look 
For 

WebTier_Setup_ErrorSummaryResults.log Web Tier installer error output 
written to a log file. Contains any 
ERROR results of the installation 
process.  

(Multiple log files for this, older 
ones from previous Web installer 
runs stored under 
InstallerLogArchive folder.) 

Any errors during 
the installation will 
be written to this 
file.  This will then 
lead you to the 
other logs for 
more detailed 
description of the 
errors. 

C:\Program Files\Deltek\Costpoint\8.2\Logs\WebTier_Installer\InstallerLogArchive 

 Copies of current log files will get 
moved to these folders if more 
than one run of the Web Tier 
installer is done. 

 

WebLogic Server Configuration 
The following methods to start and stop your Costpoint 8.2 WebLogic Server are detailed in this section: 

 Starting the Costpoint 8.2 WebLogic Server as a Windows service 

 Starting the Costpoint 8.2 WebLogic Server from the Windows Start menu 

 Starting the Costpoint 8.2 WebLogic Server from a Windows Command Prompt 

 Stopping the Costpoint 8.2 WebLogic Server as a Windows service 

 Stopping the Costpoint 8.2 WebLogic Server from a web browser 

Start Costpoint 8.2 WebLogic Server as a Windows Service 
The steps to start your Costpoint 8.2 WebLogic Server as a Windows service are detailed in this section. 

This step must be performed on your Costpoint 8.2 WebLogic application server. 

To start your Costpoint 8.2 WebLogic Server when it is installed as a Windows service: 
1. Click Start » Administrative Tools » Services. 

2. On the Services window, scroll down the Services list, right-click the Costpoint 8.2 service, and 
click Properties on the shortcut menu. 

3. On the Costpoint 8.2 Properties screen, click the General tab. 

4. Click Start to start the Costpoint 8.2 service. 

The service will indicate that it started immediately. However, please note that it will take several 
minutes for the Costpoint 8.2 service to fully initialize. After starting the service, wait several 
minutes before attempting to connect to the software. 

If you encounter problems with the Costpoint 8.2 service, check the 
C:\Deltek\Costpoint\82\logs\DEServer.log file and report any errors to Deltek Costpoint Technical 
Support. 

5. Click OK to close the Costpoint 8.2 Properties screen. 

6. Close the Services window. 
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Start Costpoint 8.2 WebLogic Server from the Start Menu 
The steps to start your Costpoint 8.2 WebLogic Server from the Windows Start menu are detailed in this 
section. 
This step must be performed on your Costpoint 8.2 WebLogic application server. 

To start your Costpoint 8.2 WebLogic Server from the Windows Start menu: 
1. Right-click Start and select Search. 

2. Enter “Costpoint 8.2,” right-click Start Costpoint 8.2, and click Run as administrator. 

 
3. This will open a Windows Command Prompt and launch a command script that starts the 

Costpoint 8.2 WebLogic Server.  

When the Windows Command Prompt window opens, you will see a series of messages scrolling 
down the screen. 

It will take several minutes for the Costpoint 8.2 WebLogic Server to start. 

4. If your Costpoint 8.2 WebLogic Server starts successfully, the following message displays on the 
lower portion of the command line shell window: 

<The server started in RUNNING mode. > 

If your Costpoint 8.2 WebLogic Server encounters errors during the startup process, the message 
will not display, and the command line shell (DOS window) may terminate. 

5. If you do not receive the message or the command line shell (DOS window) terminates, you 
should: 

 Make a copy of the C:\Deltek\Costpoint\82\logs\DEServer.log file. 

 Contact Deltek Costpoint Technical Support. 

Start Costpoint 8.2 WebLogic Server from the Windows Command 
Prompt 
The steps to start your Costpoint 8.2 WebLogic Server from a Windows Command Prompt are detailed in 
this section. 

This step must be performed on your Costpoint 8.2 WebLogic application server. 

To start your Costpoint 8.2 WebLogic Server from a command line shell: 
1. Open a Windows Command Prompt in Administrator Mode, navigate to the 

C:\Deltek\Costpoint\82\bin folder, and launch the following command script: 

StartCPWeb 

You will see a series of messages scrolling down the screen. It takes several minutes for the 
Costpoint 8.2 WebLogic Server to start. 

 If your Costpoint 8.2 WebLogic Server starts successfully, the following message displays on 
the lower portion of the command line shell window: 

Note: Due to the enhanced security in Windows Server, it is advised to that you use the 
Run as Administrator option when launching this command even if the logged in user has 
local administrative rights. 
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<The server started in RUNNING mode. > 

 If your Costpoint 8.2 WebLogic Server encounters errors during the startup process, the 
message will not display, and the command line shell (DOS window) may terminate. 

2. If you do not receive the message or the command line shell (DOS window) terminates, you 
should: 

 Make a copy of the C:\Deltek\Costpoint\82\logs\DEServer.log file. 

 Contact Deltek Costpoint Technical Support. 

Stop Costpoint 8.2 WebLogic Server as a Windows Service 
The steps to stop your Costpoint 8.2 WebLogic Server when it is running as a Windows service are 
detailed in this section. 

This step must be performed on your Costpoint 8.2 WebLogic application server. 

To stop your Costpoint 8.2 WebLogic Server when it is installed as a Windows service: 
1. Click Windows Start » Administrative Tools » Services. 

2. On the Services window opens, scroll down the Services list, right-click the Costpoint 8.2 
service, and click Properties on the shortcut menu. 

3. On the Costpoint 8.2 Properties screen, click the General tab. 

4. Click Stop to stop the Costpoint 8.2 service. 

5. Click OK to close the Costpoint 8.2 Properties screen. 

6. Close the Services window. 

Stop Costpoint 8.2 WebLogic Server from the Web Browser 
The steps to stop your Costpoint 8.2 WebLogic Server from the WebLogic console are detailed in this 
section. 

This step must be performed from a machine that has web browser client access via TCP/IP to the 
Costpoint 8.2 WebLogic application server. 

To stop your Costpoint 8.2 WebLogic Server from a Web browser: 
1. Open your web browser and enter the following case-sensitive URL: http://<IPAddress or 

ComputerName>:<Port>/console, where <IPAddress or ComputerName> identifies your 
Costpoint 8.2 WebLogic application server and <Port> identifies the unique port number that your 
Costpoint 8.2 WebLogic application server uses to listen for connections.  

You specified this port value during the Costpoint 8.2 software installation. The default port is 
7009 (for example, http://10.2.2.154:7009/console). 

2. When the WebLogic Server Administration Console screen displays, complete the following 
fields. 

Field Name Action 

Username Enter system. 
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Field Name Action 

Password Enter the password for the WebLogic Administrative user. The default 
password is weblogic. 

3. Click Login. 

4. On the Welcome system screen in the left pane, under Domain Structure, select the delteke 
node of the hierarchical tree. 

5. On the Settings for delteke screen, click the Control tab. 

6. Select the checkbox to the left of the DEServer(admin) field. 

7. Click Shutdown, and then click Force Shutdown Now. 

8. On the Domain Life Cycle Assistant screen, click Yes. 

9. Close the web browser screen. 

Change CPSUPERUSER User’s Password 
The steps to change the CPSUPERUSER user’s password are detailed in this section. 

This step may be performed from any Windows client workstation that has TCP/IP access to your 
Costpoint 8.2 WebLogic application server. 

To change the CPSUPERUSER user’s password: 
1. Open your web browser, and enter one of the following URLs: 

 http://<AppServerIPAddress or ComputerName>:<Port> 

 http://<WebServerIPAddress or ComputerName>/cpweb 

Where <AppServerIPAddress or ComputerName> identifies your Costpoint 8.2 WebLogic 
application server and <Port> identifies the unique port number that your Costpoint 8.2 WebLogic 
application server uses to listen for connections. You specified this port value during the 
Costpoint 8.2 software installation. The default is 7009. For example, http://10.2.2.154:7009. 

Or where <WebServerIPAddress or ComputerName> identifies your Costpoint 8.2 IIS Web 
server. For example, http://10.2.2.156/cpweb. 

2. On the Deltek Costpoint screen, complete the following fields. 

Field Name Action 

Username Enter CPSUPERUSER. 

Password Enter the CPSUPERUSER user’s password. The default is password. 

System Enter <Your_System_Name>, where <Your_System_Name> 
identifies the system name you assigned to your Costpoint 8.2 system 
during the Application Server Installation process. Typically, customers 
use a system name that is identical to their Costpoint 8.2 Database 
name, DELTEKCP. 
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Field Name Action 

SHOW ADDITIONAL 
CRITERIA 

Click + to display these additional fields: 

 Application: Accept the blank default value or enter a specific 
Costpoint 8.2 application (for example, COSTPOINT MENU). 

 Company: Enter your company ID (for example, 1). 

 Validation Frequency: Accept the default drop-down value, 
Field. After you have successfully logged in to Costpoint 8.2, 
review the online help for a detailed explanation of the value you 
can select for this field. 

Remember log in 
information 

Select this checkbox to have the system remember your login 
information. This option is not selected by default. 

3. Click Log In. 

4. From the main menu screen, click Admin » Security » System Security » Manage Users. 

5. On the Manage Users screen, click Query. 

6. On the Users screen, enter CPSUPERUSER in the ID field, and click Find. 

7. After the CPSUPERUSER user information loads on the Manage Users screen, click the 
Authentication tab, and complete the following fields.  

Field Name Action 

Authentication 
Method 

Accept the default value, Costpoint Database, from the drop-down list. 

Costpoint 
Password 

Enter a password for the CPSUPERUSER user.  

The password is case-sensitive and must be between 8 and 20 
characters in length. 

Verify Password Re-enter the password for the CPSUPERUSER user. 

8. Click Save. 

9. After the confirmation message displays at the bottom of the screen, click File » Close 
Application to close the Enter/Manage Users screen. 

10. Click File » Log-out to exit Costpoint 8.2.  

11. Close your web browser. 

12. Open your web browser, and enter one of the following URLs: 

 http://<AppServerIPAddress or ComputerName>:<Port> 

 http://<WebServerIPAddress or ComputerName>/cpweb 

Where <AppServerIPAddress or ComputerName> identifies your Costpoint 8.2 WebLogic 
application server and <Port> identifies the unique port number that your Costpoint 8.2 WebLogic 
application server uses to listen for connections. You specified this port value during the 
Costpoint 8.2 software installation. The default is 7009 (for example, http://10.2.2.154:7009). 
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Or where <WebServerIPAddress or ComputerName> identifies your Costpoint 8.2 IIS Web server 
(for example, http://10.2.2.156/cpweb). 

13. On the Deltek Costpoint screen, complete the following fields. 

Field Name Action 

Username Enter CPSUPERUSER 

Password Enter the CPSUPERUSER user’s password. The default is 
password. 

System Enter <Your_System_Name>, where <Your_System_Name> 
identifies the system name you assigned to your Costpoint 8.2 
system during the Application Server Installation process. Typically, 
customers use a system name that is identical to their Costpoint 8.2 
Database name, DELTEKCP. 

SHOW ADDITIONAL 
CRITERIA 

Click + to display these additional fields: 

 Application: Accept the blank default value or enter a specific 
Costpoint 8.2 application (for example, COSTPOINT MENU). 

 Company: Enter your company ID (for example, 1). 

 Validation Frequency: Accept the default drop-down value, 
Field. After you have successfully logged in to Costpoint 8.2, 
review the online help for a detailed explanation of the value 
you can select for this field. 

Remember log in 
information 

Select this checkbox to have the system remember your login 
information. It is selected by default. 

14. Click Log In. 

You can begin accessing and using the Costpoint 8.2 system: 

If you are unable to log in to Costpoint 8.2, contact Deltek Costpoint Technical Support. 

Secure Sockets Layer (SSL) Encryption with Costpoint 8.2 
Implementation 
Information regarding the Costpoint Web support for SSL encryption is detailed in this section. This 
section also provides references to additional resources that you can use to learn more about 
implementing SSL with Costpoint 8.2. 

Costpoint Web’s Support for SSL 
Costpoint 8.2 was tested against and supports SSL implemented on its WebLogic Server and Microsoft 
Internet Information Server (IIS) components. 

 

Note: The IIS component is optional in the Costpoint Web environment. If you have chosen to deploy 
IIS with your Costpoint Web environment, you may implement SSL on both your IIS and WebLogic 
Server components. 
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SSL requirements will vary from customer to customer. Consequently, this section does not provide 
specific instructions for implementing SSL on either your WebLogic Server or IIS components. Instead, 
this section provides third-party informational resources that you can use to learn about and implement 
SSL with your Costpoint 8.2 environment. 

Informational Resources for Implementing SSL 
You can implement SSL on either or both of your Costpoint 8.2 system’s IIS and WebLogic Server 
components. For help on implementing SSL, please refer to the following URLs: 

 WebLogic Server 

 http://docs.oracle.com/cd/E24329_01/web.1211/e24422/ssl.htm#SECMG384: Oracle 
WebLogic Server documentation that provides an overview of WebLogic’s domestic- and 
exportable-strength SSL licenses as well as step-by-step instructions for implementing SSL 
on your WebLogic Server. 

 IIS 

 http://technet.microsoft.com/en-us/library/cc732230(WS.10).aspx: Microsoft TechNet article 
that provides an overview of using encryption with IIS 8.2 and specific instructions for 
configuring SSL. 

 http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/5e0119a8-
deed-4056-9592-e721a4889a71.mspx?mfr=true: Microsoft TechNet article that provides an 
overview of using encryption with IIS 6.0 and specific instructions for configuring SSL. 

In addition to consulting these informational resources, you can contact Deltek’s Systems Solutions team 
to arrange assistance for implementing SSL with your Costpoint 8.2 system. 

Latest Installer Files Download Instructions 
The Costpoint Database Tier installer provides certain command-line options that can be invoked in 
special circumstances.  

To display the currently supported switches: 
1. Open Command Prompt in Administrator Mode. 

2. Navigate to the directory where the installer is located. 

3. Enter the following: DeltekCostpoint82DatabaseTier_BuildXX.exe /? 

The instructions for downloading the latest Costpoint 8.2 Database upgrade and 
DeltekCostpoint82RequirementsINI files are detailed in this section. Each installer will automatically 
download the applicable files if your servers have Internet access. If your servers do not, you will need to 
run this step for each installer. 

You must perform this step on any machine that has Internet access. 

To download the required upgrade files: 
1. Run the applicable command to retrieve the files from DSM: 

 DeltekCostpoint82DatabaseTier_Build01.exe /filedynamicdownload 

 DeltekCostpoint82ApplicationTier_Build01.exe /filedynamicdownload 

 DeltekCostpoint82WebTier_Build01.exe /filedynamicdownload 

You will see a screen similar to the following. 

http://docs.oracle.com/cd/E24329_01/web.1211/e24422/ssl.htm#SECMG384
http://technet.microsoft.com/en-us/library/cc732230(WS.10).aspx
http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/5e0119a8-deed-4056-9592-e721a4889a71.mspx?mfr=true
http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/5e0119a8-deed-4056-9592-e721a4889a71.mspx?mfr=true
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2. After the file downloads, when a message similar to the following displays, click OK. 

     
3. Copy the downloaded DeltekCostpoint82DatabaseNewInstallationFiles.exe/ 

DeltekCostpoint82RequirementsINI.exe file(s) to your server, in the same folder as your .exe 
installer file. 

 

 



 

 

About Deltek 
Better software means better projects. Deltek delivers software and information solutions that enable 
superior levels of project intelligence, management and collaboration. Our industry-focused expertise 
makes your projects successful and helps you achieve performance that maximizes productivity and 
revenue. www.deltek.com 

http://www.deltek.com/
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